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1. INTRODUCTION

1.1Purpose and Scope

This document is designed to detail the steps necessary to upgarde the functionality of the LSMS 13.0 and LSMS 13.1
on E5APPB-02 to the LSMS 13.2.X on the ESAPPB-02 cards.

This work is intended to be non-intrusive to the signaling network traffic and is to be performed within the limits of a
normally scheduled maintenance window unless otherwise stated.

It will be necessary to halt the provisioning activity during the execution of the procedures outlined herein while a full
database backup is being taken. Normal provisioning can resume once the full upgrade has completed. For any issues
incurred in implementing any part of this document, follow the contact/escalation list.

1. Before initiating the migration, you must save the TMN Toolkit and OSI licenses file in a remote location in case
backout will be required due to failure in upgrade. Also, verify the availability of a copy of the two license files with the
customer and make them aware that the license files must be kept safe.

2. Before initiating the migration, also ensure to get the TMN Toolkit and OSI licenses from Artifex in advance for the
new environment. Unless you have the new license files ready, do not start the upgrade. Contact Artifex to get the
required licenses.

The individual running this procedure must be experienced and well proficient with the following platforms and
technologies.

e  Unix/Linux Admin

e VI Editor

e |P Networking

e Oracle LSMS Platform E5-APP-B (TPD through Initial Implementation)

If you do not have these skills or if you are not completely comfortable working in an Unix or Linux system environment,

STOP - DO NOT PROCEED
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1.2References
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[1] Formal Peer Review, PD001866, latest version
[2] Work Instruction Template, TM005023, latest version

[3] Oracle Quality Manual, latest version
[4] TPD Initial Product Manufacture User’s Guide, 909-2130-001, Latest revision, Oracle

[5] LSMS 13.2 Product Functional Specification, PF006203, Latest revision, Oracle
[6] LSMS 13.2.X Upgrade/Installation Guide, Latest Version, Oracle

[7] ELAP 10.0Upgrade/Installation ProcedureE56994, Current Version, Oracle

[8] Query Server Installation and Upgrade Instructions, Latest Version, Oracle

1.3Acronyms

Table 1. Acronyms

BIOS Basic Input Output System

DB Database

E5-APP-B/ESAPPB Eagle5 Application Card class B cpu/board
E5APPB-02 E5 Based Application card installed with 480G SSD Hard Drive
ELAP Eagle LNP Application Processor

IPM Initial Product Manufacture

LSMS Local Service Management System

NAS Network Attached Storage

NPAC Number Portability Administration Centre
QS Query Server

SERVDI Support ELAP Reload Via Database Image
TPD Tekelec Platform Distribution

MPS Multi Purpose System

1.4Definitions

Table 2. Definitions

Active LSMS

Standby LSMS

LSMS on which data is replicated from the Active LSMS.

System health check

performed using the TPD syscheck utility.

1.5Terminology

Multiple servers may be involved with the procedures in this manual. Therefore, most steps in the written procedures

begin with the name or type of server to which the step applies. For example:

Full Upgrade for LSMS 13.2

LSMS on which the sentry is running and it takes updates from the NPAC.

Procedure used to determine the health and status of the LSMS server, typically
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Bl sfep has acheckbox for every cormmaad witlin fthe sfep that the
fechmicia shadd check fo kesp fradt of the progress of fhe procedure.

The fifle box describes fhe operafions fo be performed durving that sfep.
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Each command that the fechnicianis fo enfer isin g point Lucida Console fouf

\

1

MPS A: Verify all

D materials required

are present

Materials are listed in Material List (Section 1.6)

Figure 1. Example of a step that indicates the Server on which it needs to be executed

1A | 18 | MPS X: Insert Insert media in USB drive

0O O USB.

Figure 2. Example of a step that needs to be executed on both MPS A and MPS B servers

1.6Required Materials

Two (2) target-release USBs or a target release 1SO file.

A terminal and null modem cable to establish a serial connection.

100mbps link is required for database transfer to remote server.

System configuration information like NTP Server IP, App IP, ELAP IP etc.

Write down the system configuration information.

App IP:

App Gateway:

NTP Server IPs:

ELAP Server IPs:

NPAC Server IPs:

NMS IPs:

Other IPs required:

Passwords for users on the local system:
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LSMS USERS

login

MPS A password

MPS B password

Ismsmgr

Ismsadm

Ismsall

Ismsuext

Ismsuser

Ismsview

root

mysql dbroot user

admusr

Command-line

Table 3: User Password Table

Note: After the MPS servers are IPM’ed with TPD 7.0.x, then “root” user access is disabled. “admusr” can be used if
required to access the MPS servers. After the installation of LSMS application the “root” user access is again enabled.

1.7E5APPB Server (Rear

Figure 3. E5-APP-B Server (Rear)

Full Upgrade for LSMS 13.2
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1.8 Switch Configuration

VLAN configuration on the switch is done based on the Error! Reference source not found. (LSMS/NAS S
egmented Type Configuration). Please note that the VLAN IDs can be different based on the LAB network
configuration.

Name [VTag| Rout If | Tagged ports | Untagged ports

default |1 | swO | |1/1/1-1/1/24

vlan2 |2 ||1/1/3,1/1/4 |

vlan3 |3 |1/1/3,1/1/4 |

naspri-network |5 | [1/1/3,1/1/4,1/1/17 |
nassec-network |6 | |1/1/3,1/1/4,1/1/18 |
elap-network |159 | [1/1/3,1/1/4,1/1/19 |
gui-network |161 | [1/1/3,1/1/4,1/1/20 |

Optionally assign some name to the switch ports:
interface 1/1/3

name LSMS-A_NAS/ELAP/GUI
!

interface 1/1/4

name LSMS-B_NAS/ELAP/GUI
!

interface 1/1/17

name LSMS-A_NAS-pri

!

interface 1/1/18

name LSMS-B_NAS-sec

!

interface 1/1/19

name ELAP-network-uplink

!

interface 1/1/20

name Gui-network-uplink

1.9Fallback
If for any reason a fallback to the original configuration is required, the procedure will be to re-IPM the server and
install the old LSMS version.
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2. GENERAL DESCRIPTION

This document defines the step-by-step actions performed to execute a software full upgrade to ESAPPB-02.

The LSMS application can be installed, or upgraded based on the table below.

Table 4 Install-Full Ugrade paths for ESAPPB-02

TPD Release for IPM LSMS Initial Installation Release
7.0.x.0.0-86.40.0 or later 13.2.X
Full upgrade Source Release Full upgrade Destination Release
13.0 13.2.X
13.1 13.2.X

*Note : LSMS 13.2.X is supported on ESAPPB-02 cards only

The LSMS upgrade paths are shown in the figures below. The general timeline for all processes to perform a software

upgrade, from pre-upgrade backups to a final system health check, is also included below.

This document covers
migration from L5MS 13.0to
LSMS 13.2.

LSMS 13.0x-y.y.y . L5MS 13.2.a-b.b.b

on an ESAPPB-02 Migrate on an ESAPPE-02

Figure 4: Full upgrade Path - LSMS 13.0 to 13.2.X

This document covers
migration from LSMS 13.1:to
LSMS 13 .2,

LSMS 13 1-yyy __. LSMS 13.2.a-b.b.b

on an ESAPPB-02 Migrate on an ESAPPB-02

Figure 5: Full upgrade Path - LSMS 13.1 to 13.2.X
Full Upgrade for LSMS 13.2
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3. FULL UPGRADE PROCEDURES
3.1 Upgrade Timeline for LSMS Procedure Execution Order

3.1.1.1 Preparation phase

Table 5: Timeline table for full upgrade preparation

LSMS 1A LSMS 1B
Procedure Task 1A | Task 1B Task Procedure
Start
time
(min)
1.0Procedure | Setup upgrade environment 5 0
1-
5 5 | Setup upgrade 1.0Procedure
environment 1-
1.0Procedure | Pre Full upgrade Health 5 10
2- Check
1.0Procedure | Verify LSMS QS 10 15
3 - Error!
Reference
source not
found.
25

3.1.1.2 Maintenance Window Tasks

Table 6: Timeline table for Maintenance Window Task

LSMS 1A LSMS 1B
Procedure Access Task 1A | Task | 1B Task Access Procedure
Method Start Method
time
(min)
1.0Procedure | Direct Disconnect 10 0
4- SSH ELAP from
1.0Procedure LSMS
5- Disconnect
NPAC from
LSMS
1.0Procedure | Direct Backup LSMS 120 10 10 | IPM MPS B Minicom | 1.0Procedure
6 - SSH DB 0 | server and NAS mate for | 8-
server MPS B
Transfer and
1.0Procedure Database to Minicom
7 - Remote Server nas for
NAS
server
Pre-Install Minicom
Configuration mate
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1.0Procedure

Install the Minicom | 9 -

Application mate

Configure Minicom

Network mate Procedure 10

interfaces using

platcfg utility 1.0Procedure
11 -

Configure Time | Minicom
Zone and Clock. | mate

TMN Toolkit Minicom

and Marben OSI | mate 1.0Procedure
License 13-
Installation

1.0Procedure

16 -

1.0Procedure | Minicom | IPM MPS A 60 130
8- mate server

Pre-Install
1.0Procedure Configuration
9-
1.0Procedure | Minicom | Install the 25 190
10 - mate Application
1.0Procedure | Minicom | LSMS Initial 15 215
12 - mate Configuration
1.0Procedure | Minicom | Configure Time 5 230
13 - mate Zone and Clock.
1.0Procedure | Minicom | Network 10 235
14 - mate Configuration
OR for LSMS Cards.
1.0Procedure
15 - Error! *Note: For
Reference Single Subnet
source not Configuration
found. execute

Procedure 13

and for

Segmented

Subnet

Configuration

execute

Procedure 14.

1.0Procedure | Minicom | TMN Toolkit 5 245

16 - mate and Marben OSI
License
Installation
1.0Procedure | Minicom | Start LSMS 10 | 250
17 - mate services
Minicom | Post 5 260
1.0Procedure | mate Configuration
18 - Health Check

Full Upgrade for LSMS 13.2
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1.0Procedure | Minicom | Restore Database | 60 | 265
19 - mate
1.0Procedure | Minicom | Connect LSMS 15 | 325
20 - mate 13.2.X to NPAC
1.0Procedure | Minicom | Connect LSMS 10 340 5 | Accept the Direct 1.0Procedure
22 - mate 13.2.X'to ELAP upgrade SSH 23 -
1.0Procedure | Minicom | Accept the 5 350
23 - mate upgrade
Upgrade 355
Completed
3.1.1.3 Post Upgrade Phase
LSMS 1A LSMS 1B
Procedure Task 1A | Task 1B Task Procedure
Start
time
(min)
1.0Procedure | Export the Database from 60 0
21 - LSMS 13.2.X to the Query
Server
60

3.2Pre Full upgrade Steps
Check off (V) each step as it is completed. Boxes have been provided for this purpose under each step number.

Should this procedure fail, Contact My Oracle Support following the instructions on the Appendix E.

Procedure 1 -

SETTING UP FULL U

PGRADE ENVIRONMENT

Procedure 1 - Setting Up Full upgrade Environment

3 . .
T This procedure sets up the full upgrade environment.
E A . . .
p Estimated time: 5 minutes
#
|:| I:l MPS X: SSH to MPS IP:
1 : Togin: root
Login as root to MPS Password: <root_password>
MPS X: Start a capture_file using Iso Console, or by
5 0Ol 0O ) ) starting a local screen session and capturing
Start capture file. its output.
MPS X:
3 [0 | O | Access mate MPS via # minicom mate
serial console
. console Togin: root
4 Ol O mate MPS: Password: <root_password>
Login as root.
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This procedure is complete!

Procedure 2 -

PRE-FULL UPGRADE SYSTEM HEALTH CHECK

Note: This procedure may be executed outside of the maintenance window.

Procedure 2 — Pre-Full upgrade System Health Check

This procedure determines the health of the MPS before and after full upgrade.

Estimated time: 5 minutes

D = o m-H®»

MPS A and B: Log into

the server as the user “root”.

Login: root
Password: <root_password>

[] N

MPS A and B:

Validate date, time and time
zone to ensure accuracy.

# date
Thu May 12 05:55:27 EDT 2016

Execute the following command on both LSMS A and B to verify the HA state of

server’s MySQL replication
is functioning properly.

3. | MPS A and B: § ’
[ ]| Execute the “hastatus” mated LSMS pair.
command_to verify the HA # hastatus
state of this server.
Verify that the hastatus of one of the servers is Active and the other is Standby.
WARNING: If the output from the above command is anything else other than
“ACTIVE” and “STANDBY”, do not proceed with this procedure and contact My
Oracle Support following the instructions on the Appendix E.
4. | LSMS Standby server: Execute the following command to verify that MySQL replication is working
| Verify that the STANDBY correctly on the STANDBY LSMS server:

# tail /var/TKLC/1sms/logs/dbrepMon.log

If MySQL replication is functioning correctly then the following output will be
observed, make sure that at least the last line of your output matches the lines
below.

A1l
ATl
A1l
ATl
A1l
ATl
A1l
ATl
A1l
ATl

wed
wed
wed
wed
wed
wed
wed
wed
wed
wed

06:20:09
06:21:14
06:22:18
06:23:23
06:24:27
May 18 06:25:33
May 18 06:26:37
May 18 06:27:42
May 18 06:28:45
May 18 06:29:50

2016
2016
2016
2016
2016
2016
2016
2016
2016
2016

STANDBY
STANDBY
STANDBY
STANDBY
STANDBY
STANDBY
STANDBY
STANDBY
STANDBY
STANDBY

May 18
May 18
May 18
May 18
May 18

tests passed on

tests passed on
tests passed on
tests passed on
tests passed on
tests passed on
tests passed on
tests passed on
tests passed on

tests passed on

Full Upgrade for LSMS 13.2
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Procedure 2 — Pre-Full upgrade System Health Check

WARNING: If at least the last line of your output does not match the lines above
then do not proceed with this upgrade and contact My Oracle Support following the
instructions on the Appendix E.
5 | LSMS Active server: Execute the following command to verify that MySQL replication is working
Verify that the ACTIVE correc-tly on the ACTIVE LSMS server:
server’s MySQL replication | # tail /var/TKLC/1sms/logs/dbrepiMon.log
is functioning properly. If MySQL replication is functioning correctly then the following output will be
observed, make sure that at least the last line of your output matches the lines
below.
Thu Jun 9 05:30:13 2016 EVENT: LSMS_EVENT_MON ACTION: CLEAR
MSG: DB Monitoring Good
Thu Jun 9 05:30:13 2016 All tests passed on ACTIVE
Thu Jun 9 05:31:14 2016 A1l tests passed on ACTIVE
Thu Jun 9 05:32:16 2016 All tests passed on ACTIVE
WARNING: If at least the last line of your output does not match the lines above
then do not proceed with this upgrade and contact My Oracle Support following the
instructions on the Appendix E.
6. | MPS A and B: # syscheck
]| Execute syscheck Running modules in class disk...
OK
Running modules in class services...
oK
Running modules in class system...
OK
Running modules in class Ismshc...
oK
Running modules in class hardware...
OK
Running modules in class proc...
OK
Running modules in class net...
OK
LOG LOCATION: /var/TKLC/log/syscheck/fail_log
7| LSMS Active server: Execute the following command on the ACTIVE LSMS server to display the
| Capture the output of current LSMS sentry status:
‘sentry status’ command
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Procedure 2 — Pre-Full upgrade System Health Check

# sentry status

NOTE: Verify that the output displays a Status of “running” for all processes; the
regional processes (npacagents) may or may not be associated in the Comment
field. If the output from this command displays any other Status than “running”
contact My Oracle Support following the instructions on the Appendix E.

Capture the output from this command and make it available to Oracle Technical
Services if required.

8. | LSMS Active server:

SSH to NAS server and
execute syscheck.

# ssh backupserver
# syscheck

Running modules in class disk...
OK

Running modules in class services...
OK

Running modules in class system...
OK

Running modules in class lsmshc...
OK

Running modules in class hardware...

OK
Running modules in class proc...

OK
Running modules in class net...

OK

LOG LOCATION: /var/TKLC/log/syscheck/fail_log

A

Repeat on the day of the
] scheduled full upgrade

All Health Checks should be repeated the day of the full upgrade. If any problems
are encountered, resolve before proceeding further.

This procedure is complete!

Procedure 3 - VERIFY LSMS QUERY SERVER

Procedure 3 - Verify LSMS Query Server

S
T
E

o

Full Upgrade for LSMS 13.2

This procedure determines if the LSMS 13.0/13.1 has an Optional Query Server.
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# | Estimated time: 10 minutes
1. | LSMS Active server: Login: Tsmsadm
] | Log in to the server as the | Password: <Tsmsadm_password>
user “Ismsadm”.
2. | LSMS Active server: $ /usr/TKLC/1sms/tools/1smsdb -c queryservers
] Verify if the Query Server | /usr/TKLC/1sms/tools/Ismsdb: Query Server Feature is not
Feature is active on the enabled.
LSMS System. ———OR---
cs2-bss2 (<LSMS Query Server IP>) Connected
___OR___
cs2-bss2 (<LSMS Query Server IP>) Disconnected
3. LSMS Active server: .
If the Query Server exists on the LSMS System, note the IP address (es) for later use.
] | Note down the Query
Server IP Address (es).
4. | LSMS Query server: SSH to Query Server IP:
[] | Login to customer’s query login: PO?t
server as root and record the Password: <root_password>
MySQL version $ mysql -v
mysgl Ver 14.14 Distrib 5.6.29, for solarisl10/11 (sparc)
using EditLine wrapper
Note: The minimum acceptable version is 5.6.29. Query servers that are at less than
5.6.29 must be upgraded before running the query server procedure. Please refer to the
document [8] to upgrade the Query Server.
This procedure is complete!

3.3Data Backup before Full upgrade

Procedure 4 -

DISCONNECT ELAP FROM LSMS

Procedure 4 - Disconnect ELAP from LSMS

? This procedure disconnects the ELAP from LSMS.
E | Estimated time: 5 minutes
P
# | Note: This procedure needs to be executed on all the connected ELAPs.
1. | ELAP Active server: NOTE: Verify the following.
[] | Verify ELAP 10.0 install ] ] )
1. ELAP 10.0 is successfully installed and configured.
2. ELAP 10.0is connected to Eagle for data download
2. | LSMS Active server: Login: 1smsadm
] | Log in to the server as the Password: <1smsadm_password>
user “lsmsadm”.
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3. | LSMS Active server:

] | Disconnect the connected

% eagle status

Look for all connected ELAPs and disconnect each of them.

] | Loginto ELAP GUI

ELAPs
$ eagle stop <ELAP CLLI>
eagle: Stopping...
eagle: eagleagent STPA stopped at Tue Apr 26 05:48:52 2016
4. | ELAP Active server:

Login to the ELAP (connected to LSMS) GUI through VIP as uiadmin.

5. ELAP Active server:

[] | Disable the Bulk Download

Go to menu Maintenance -> LSMS HS Bulk Download -> Change Enabled
Click on ‘Disable LSMS Bulk Download for this ELAP’ button.

ELAP_A_NAME Change LSMS HS Bulk Download Enabled

i INFO: The LSMS Bulk Download for this ELAP is currently Enabled.

A CAUTION: This action will Disable the LSMS Bulk Download for this ELAP.

I Disable LSMS Bulk Download for this ELAP

2013 © Tekelec, Inc., All Rights Reserved.

ELAP_A_NAME Change LSMS HS Bulk Download Enabled

“ SUCCESS: The LSMS Bulk Download for this ELAP is now Disabled

2013 © Tekelec, Inc., All Rights Reserved.

[] | Disconnect LSMS
connection

6. | ELAP Active server: ) )
. Go to menu Maintenance -> LSMS Connection -> Change Enabled
[] | Disable the LSMS . iy i
. Click on ‘Disable LSMS Connection’ button.
Connection
ELAP_A_NAIVIE Change LSMS Connection Allowed
i INFO: The LSMS Connection is currently Enabled.
& CAUTION: This action will Disable the LSMS Connection_
- 2013 ® Tekelec, Inc., All Rights Reserved.
ELAP_A_NA[VIE Change LSMS Connection Allowed
V SUCCESS: The LSMS Connection is now Disabled
2013 & Tekelec, Inc., Al Rights Reserved.
7. | All connected ELAPs:

Repeat the steps 4 to 6 for all ELAPs connected to LSMS.

This procedure is complete!

Procedure 5 -

DISCONNECT NPAC FROM LSMS

Procedure 5 - Disconnect NPAC from LSMS

S
T

E
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; Estimated time: 5 minutes
1. | LSMS Active server: Login: Tsmsadm
] | Log in to the server as the Password: <1smsadm_password>
user “lsmsadm”.
2. | LSMS Active server: Execute the followin_lg command to list the active NPAC regions
] | Stop all connected NPAC $ dbnames -n alTl -a
regions Canada CanadaDB
MidAtlantic MidAtlanticDB
Midwest MidwestDB
Northeast NortheastDB
Southeast SoutheastDB
Southwest SouthwestDB
WestCoast WestCoastDB
Western WesternDB
Note: The above output shall vary depending on LSMS configuration.
Execute the following command to stop an NPAC region.
$ Isms stop <region name>
Checking if npacagent 1is running....Yes.
Stopping npacagent....
OK.
npacagent stopped: Wwed Jan 2 05:52:42 2014
command complete.
Execute the above command for all active regions.
3. | LSMS Active server: ) )
[] | Loginto LSMS GUI Login to LSMS Active GUI through VIP as ‘Ismsall’ user.
4. | LSMS Active server: ) .
[] | Deactivate all active regions Click on the NPAC region.
g Go to the menu Configure -> LNP System -> NPAC -> Modify -> Primary
Uncheck the ‘Activate Region’ checkbox and click ‘OK’.
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7.2 Modify LNP System NPAC <Canada, primary> [z

SMS Name [Regiond MNPAC Canada Activate Region

Address Info | Component Info | Contact Info | Comm Info

MPAC OS5 Address

PSEL |ow? SSEL |ow7 TSEL NSAP {10 248 |10 |5

LSMS OS] Address

PSEL psel 55EL ssel TSEL N3AP 10 248 10 VB

MPAC FTP Address

100|248 |10 |5

E Modify NPAC Component?

OK Cancel

Note: Similarly, Deactivate all the active NPAC regions.

This procedure is complete!

Procedure 6 - BACKUP LSMS DB

Procedure 6 - Backup LSMS DB

[] | Record DB counts

? This procedure outlines the steps to backup the LSMS DB.

E | Estimated time: 90 minutes

P

# | NOTE: The estimated time may differ depending on the DB size.

: . Login: root
- LSMS Active server: Password: <root_password>
[] | Log in to the server as the
user “root”

2. LSMS Active server:

# 1smsdb -c counts

3. LSMS Active server:
[] | Remove existing DB

# rm -rf /var/TKLC/1sms/free/mysql-snapshot-*
# rm -rf /var/TKLC/1sms/free/snapinfo.sql

“QUERY_SERVER” and
“RESYNCDB_QUERY_S
ERVER” Feature

snapshots
4. LSMS Active server: Execute below command to verify “QUERY_SERVER” and
[ | Enable “RESYNCDB QUERY_ SERVER?” feature is enabled:

# 1smsdb -c features | grep —w QUERY_SERVER
# 1smsdb -c features | grep -w RESYNCDB_QUERY_SERVER

If these features are not enabled then execute the below commands to enable them:

Full Upgrade for LSMS 13.2
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# su - Tsmsadm

$ dbcfginternal QUERY_SERVER Y
Provide the “Customer Service ID”

$ dbcfginternal RESYNCDB_QUERY_SERVER Y
Provide the “Customer Service ID”

$ exit

LSMS Active server:
Backup the LSMS DB

# 1smsdb —-c snapshot

WARNING: This command may cause a brief interruption in
traffic being sent from the NPAC to connected network
elements and Tocal LSMS provisioning may be INTERRUPTED.

Do you want to continue? [Y/N]Y

Creating snapshot of the database partition, please wait...

File descriptor 5 (socket:[34104267]) Tleaked on lvcreate

invocation. Parent PID 28676: /usr/TKLC/1sms/tools/1smsdb
Logical volume "dbbackup" created

The database 1is available to the application again.

Disk snapshot created successfully.

Snapshot mounted successfully.

Created snapinfo.sql file successfully

MidAtTanticDB/

MidAtlanticDB/NumberPoolBlock. frm

MidAtTanticDB/ServiceProvNetwork.MYD

Logica] volume "dbbackup" successfully removed

Note: The execution time of the above command shall vary according to the DB
size.

Verify that the following snapshot files are created at /var/TKLC/Isms/free
directory:

e mysql-snapshot-noreplDB.tar.gz

e mysql-snapshot-supDB.tar.gz

e mysql-snapshot-<regionDB>.tar.gz

e snapinfo.sgl

&

LSMS Active server:

Verify the snapshot files for
all existing NPAC regions

Execute the following command and verify that the snapshot files are created for
all the NPAC regions listed in the command output.
Note: The below command shows only the regions for which the DB exists.

# 1smsdb -c dblist
CanadaDB
MidAtlanticDB
M1idwestDB
NortheastDB
ReplTestDB
SoutheastDB
SouthwestDB
WestCoastDB
westernDB

TogDB

mysq1l

norep1DB
performance_schema
SupDB

~

LSMS Active server:

Execute the following command on LSMS Active server CLI to take MySQL
dump of the supDB database.
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Take MySQL dump of
supDB.

# mysqldump -udbroot -p[dbroot_password] supDB >
/var/TKLC/1sms/free/supDBdump.sq]l

Note: Below warning message can be ignored if displayed:
warning: Using a password on the command line interface can
be insecure.

®

LSMS Active server:

Take MySQL dump of
mysgl.user.

Create MySQLUserGrants.sql file listing all the users and their privileges using
the following shell script MySQLUser.sh in the root directory:

File: MySQLUser.sh
MYSQL_CONN="-udbroot -ppassword"

mysql ${MYSQL_CONN} --skip-column-names -A -e "SELECT
CONCAT( 'SHOW GRANTS FOR ''',user,'''@''’',host,"''’';"') FROM
mysql.user WHERE user<>'"'" | mysql ${MYSQL_CONN} --skip-
column-names -A | sed 's/$/;/q9' |sed 's/IDENTIFIED BY
PASSWORD/IDENTIFIED BY/g' >
svar/TKLC/1sms/free/MySQLUSerGrants.sql

Note: Edit MYSQL_CONN for the proper connection properties and this will
generate the MySQLUserGrants.sql file with grant statements from the 5.0
machine that you can source into the 5.6 machine.

Run the MySQLUser.sh file to generate MySQLUserGrants.sql

# chmod +x MysSQLUser.sh
# ./MysQLUser.sh

The content of the MySQLUserGrants.sgl will be like:
GRANT USAGE ON *.#* TO 'lsmsadm'@'%' IDENTIFIED BY
'570851ac3cc01499';

Edit the .sqgl file and replace the password of all the users with plain text password

to contain something like:
GRANT USAGE ON *.* TO 'lsmsadm'@'%' IDENTIFIED BY 'password-
in-plain-text';

Note: There is no way to reverse the hash to recover the plain text. So the
customer has to provide us the plain text passwords or we can assign default
passwords which the customer/end user can change later on.

A

LSMS Active server:

Log into the Active LSMS
server GUI

Login to LSMS GUI as Ismsall user.

10.

LSMS Active server:

Record the configured
MySQL Port

Go to “Admin -> MySQL Port -> View” and record the configured MySQL Port.

LSMS Active server:

Record the configured
ELAP Credentials

Go to “Configure -> LNP System -> EMS -> View” and record the configured
ELAP Credentials.

This procedure is complete!
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Procedure 7 - Transfer Database to Remote Server

? This procedure transfers the database backup from the LSMS server to the remote server.
E | Estimated time: 30 minutes
P
# | Note: 100mbps link is required for database transfer to remote server.
. . Login: root
1. | LSMS Active server: Password: <root_password>
Log in to the server as the
user “root”
2. LSMS Active server: # ping <remote IP> —C 3
[J/| Verify Connectivity PING <Remote IP> (<Remote IP>) 56(84) byt f dat
<Remote > (<Remote > ytes O ata.
between the LSMS and the 64 bytes from <Remote IP>: icmp_seq=1 tt1=64 time=0.022 ms
remote server. 64 bytes from <Remote IP>: jcmp_seq=2 tt1=64 time=0.020 ms
If the remote server cannot 64 bytes from <Remote IP>: icmp_seq=3 tt1=64 time=0.020 ms
be pinged, verify the --- <Remote IP> ping statistics ---
network connectivity. 3 packets transmitted, 3 received, 0% packet Toss, time
2001ms
rtt min/avg/max/mdev = 0.020/0.020/0.022/0.005 ms
3. | LSMS Active server: # 1s -1rt /var/TKLC/1sms/free/*snapshot*
] | List the snapshot files # 1s -1rt /var/TKLC/1sms/free/supDBdump.sql
# 1s -1rt /var/TKLC/1sms/free/MySQLUserGrants.sql
4. | Remote server: # rm /var/TKLC/1sms/free/mysql-snapshot-*
] | Remove the existing DB # rm /var/TKLC/1sms/free/supDBdump.sql
snapshot files # rm /var/TKLC/1sms/free/MySQLUserGrants.sql
> LSMS Active server: Transfer all the NPAC region DB hot files, the MySQL d f supDB and
[T | Copy snapshot files to a ransfer all the region snapshot files, the MySQL dump of supDB an

Remote Server. the MySQL dump of mysqgl.user

Note: The NPAC regions are: CanadaDB, MidAtlanticDB, MidwestDB,

NortheastDB, SoutheastDB, SouthwestDB, WestCoastDB and WesternDB
# scp -p /var/TKLC/1sms/free/mysql-snapshot-<NPAC
region>. tar.gz root@<Remote IP>:<Remote IP Path>
Password: <root_password>

# scp -p /var/TKLC/1sms/free/supDBdump.sql root@<Remote
IP>:<Remote IP Path>
Password: <root_password>

# scp -p /var/TKLC/1sms/free/MySQLUserGrants.sql
root@<Remote IP>:<Remote IP Path>
Password: <root_password>

or
# cd /var/TKLC/1sms/free/

# sftp <username>@<IP address of remote computer>
Connecting to <IP address of remote computers...

The authenticity of host '<IP address of remote computer>'
can't be established.

DSA key fingerprint is
58:a5:7e:1b:ca:fd:1d:fa:99:f2:01:16:79:d8:b4:24.

Are you sure you want to continue connecting (yes/no)? yes
warning: Permanently added '<IP address of remote computer>'
(DSA) to the 1ist of known hosts.

<username>@<IP address of remote computer>'s password:
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sftp> cd <target directory>

sftp> put mysgl-snapshot-<NPAC region>.tar.gz
Uploading mysql-snapshot-<NPAC region>.tar.gz
sftp> put supDBdump.sql

Uploading supDBdump.sql

sftp> put MysSQLUserGrants.sql

Uploading MySQLUserGrants.sql

sftp> bye

. # 1s -Trt /var/TKLC/Tsms/free/*snapshot*

Remote Server: # 1s -1rt /var/TKLC/1sms/free/supbBdump.sql

[ | Verify the snapshot filesare | # 1s -Trt /var/TKLC/1sms/free/MysQLUserGrants.sql
present on the remote
server.

o

This procedure is complete!

3.41PM and LSMS 13.2.X Installation

Procedure 8 - IPM MPS SERVER WITH 64 BIT TPD 7.0.X

Procedure 8 - IPM MPS Server with 64 bit TPD 7.0.x

This procedure will remove the LSMS application and all the data from the server.
B Estimated time: 45 minutes

NAS
Note : Below procedure needs to be executed on both MPS A, MPS B and NAS
Servers.

H=OMmMH®
>

_

MPS X: Reboot server

Ol 0| o | nsert TPD 7.0 # reboot
USB media into the
USB port

2 MPS X:
Press ‘del’ key to
enter the BIOS.

Enter System Time
and System Date.
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3. MPS X:

Select Boot 2 Hard
Disk Drives option

* Hard Disk Drives

4. MPS X:

Press ‘Enter’ key
and select USB as
the 1%t Drive

1zt Drive [USE:SHART USE]

5 MPS X:

Press ‘Esc’ key and
O] O | O | select Boot Device
Priority
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* Boot Device Priority

6. MPS X:
Verify that the 1%
Boot Device is set
to USB.
1st Boot Dewvige [USE: SHART USE]
HIREEEN
7. MPS X:

Press ‘Esc’ key and

select Exit = Save
EjEE g Changes and Exit
option

Full Upgrade for LSMS 13.2
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Save Changes and Exit

8. MPS X:

Select [OK] to save
the configuration
changes.

Smve Changes and Exic

The server will
reboot and TPD
boot prompt will
appear.
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9. MPS X: 1 labts105121labs.nc tekelec.com - PuTTY ' “‘ ::--E.Eﬂ

| -
Start the IPM . Welcome to Tekelec Platform Distribution!
process by entering Release: 7.0.3.0.0 86.41.0
the TPDIvm Arch: xB6 64

Command at the For a detailed description of all the supported commands and their options,
please refer to the Initial Platform Manufacture document for this release.
boot prompt. I In addition to linux & rescue TPD provides the following kickstart profiles:

I [ TEPD | TPDnoraid | TFDlvm | TPDcompact | HDD ]
Commonly used options are:

console=<console option>[,<console option>] ]
primaryConsole=<console option> ]
rdate=<server ip> ]

scrub ]

reserved=<sizel>[,<sizeN>] ]
diskconfig=HWRAID[, force] ]
drives=<device>[,device] ]

guestArchive ]

To install using a monitor and a local keyboard, add console=tty0

boot: IFDlvm scrubl -
10. MPS X:
After a few seconds,
additional messages rm:unt:i.ng x’dew’p;s [unix98 pty) filesystew... done
” be in scrollin mounting /sys filesystem... done
wi g g anaconda installer init wversion 13.21.239 using a serial console
by on the screen as trying to remount root filesystem read write... done
I:‘ I:‘ I:‘ the Linux kernel mounting /tmp as twpfs... done
running install...
bO,OtS’ and then the running /shin/ loader
drive formatting and | qececting nardvare. ..
file system creation | waiting for hardware to initialize...
steps will begin.
1. MPS X:
Once the drive
formatting and file Weleome to Oracle Linux Server for x86 64
system creation
steps are complete,
the screen at right
will appear I Package Installation I
indicating that the
Ololo package installation -
has begin.
Packages cowmpleted: 160 of 330
nstalling groff-1.18.1.4-21.el6.x86_64 (5 ME)
L document formatting system
12.

MPS X:
0o g
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Once all the
packages have been
successfully
installed, the screen
at right will appear
letting you know the
installation process
is complete.

Remove USB
media before
Reboot.

On MPS server
press <ENTER> to
reboot the system
and continue with
the next step.

Welcome to

Congratulations

P

Oracle Linu:x

our Oracle Linux

Complete

r installation is c

13.

MPS X:

Press ‘del’ key to
enter the BIOS

LS

PCIFnP

Baoot

R R IR IR N IR IR R R R R E N RN R R N PR RN RN RN R E R IR TR N RN ENINEN NS RTRTENEAENENERY

A

I T

]

Syatem Overview ¥
FETREEFEdtrad e Rt s dididEvEdodoa e AeEvadaradadtodatat &
AHIBIOS E
Version :06.00.15 g
Build Date:11/19/12 *
ID OACAADDE *
T

Processor ¥
Intel (R) Xeon(R) CPU L5238 ® Z.66GHZ *
Speed 12666HHz i
Count il g
*

Syatem Hemory g
Size 18192HB *
*

[rhis 1527 *

System Date [Ved 04/20/2016] ®
T

T

*

Uze [ENTER], [TLE]
or [SHIFT-TAE] to
select a field.

Use [+] or [-] to
configure system Time.

* Select Screen
B select Item
+= Change Field
Tabh  Select Field

F1 General Help
F10  Sawe and Exit
ESC  Exit

I L

I |

R R R R R N A R R R R R A A R R e E T R A SR RN AN R A A F A F S AR AR A SR A F RN E4E

14.

MPS X:

Select Boot = Hard
Disk Drives option
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* Hard Disk Driwves

15. MPS X:

Press ‘Enter’ key
and select HDD:PO

as the 1% Drive
13t Drive [HDD:PC- INTEL S5D5C]

16. MPS X:

Press ‘Esc’ key and
O (0O | O | select Boot Device
Priority

Full Upgrade for LSMS 13.2
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* Boot Device Priority

17. MPS X:
Verify that the 1%
Boot Device is set Boot Day
to HDD:PO.
igt Boot Device [HDD:PO-INTEL SSDSC)
Oaja|f
18. MPS X:

Press ‘Esc’ key and

select Exit = Save
H) R Changes and Exit
option
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IR N RN I RN R NN RN IR I T R TN N EN R R R E N I T R TN BN EN R TR NI RS NENENEA RSN INEARY

* Exit Options * Exit system setup T
T EE R IR IR RN NI N E N E AR RN ENEN RN ENENREEINEL RN EINETENRTEREY & !ft!r :!u‘.ring th! £ 3
' * changes. H
* Discard Changes and Exit * ®
* Discard Changes * F10 key can be used ¥
- * for this operation. ]
* Load Optimal Defaults i 1
* Load Failsafe Defaults X x
* * T
L3 * £ 4
® w L
£ * x
d LI Jelect Screen a
- R Select Item ’f
* * Enter Go to Sub Screen *
- * Fi General Help =
* * FiI0  Save and Exit ]
* * ESC  Exic X
* * T
T x t 3
T L]

19.

m MPS X:

MPS X:
Hain anced PCIPDP Boot Security Exi

SeleCt [OK] to Save B R R R R R R R A R IR I AR A RN R R AR A R A R AN IR AN R NN A R RS RN R AR N A I SN RN SR EA A IAEL S

the COﬂfIgUfatlon * Exit Options * Exit system setup *

Changes. The server T OATEREREREAIREATAIAIRIASAIRATARSETAFEAINRAENENEFEFEF 7 after maving the ]

will reboot. r # changes. i
* Discard Changes and Exit K “
* Discard Changes * F10 key can be used “
& * for this operation. :
T L';lad Optlml thﬂ'fﬂ'tt’*t*titititttttt#ititttttt#t*t*t*i#i*iﬁiﬂ't £
* Load Failsate * L *
K * Save configuration changes and exit setup? = '
T T T L
T AR A AR ARANA AR ARt ARdARd Rttt At Rt RtdaRtitntd| ]
. . [ i) | [Cancel] . .

D T R AN AN A A AR RN AN I AR F R A RN RN EA RN IR ANAR IR c Screen ]
K ct Item ’
K * Enter Go to Sub Screen *
¥ *Fl General Help L
i * Fl0 Save and Exit x
i * E3C Exit x
z 3 E ]
z 3 E ]
When the message ""Upstart Job ntdMgr: started", is displayed, press the
Enter Key to get the Login prompt.
20. ] . console Togin: root
MPS X: Loginto password: <root_password>
[ | the server as the
user “root”
21. # getPlatRev

7.0.x.0.0-y.z.0
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Verify that the
platform revision is
same as the 1SO
used.

This procedure is complete!

Procedure9- PRE INSTALL CONFIGURATION

Procedure 9 — Pre-Install Configuration

?_ This procedure will perform the initial configuration required for LSMS installation.
E A g | Estimated time: 15 minutes
; Note: Below procedure needs to be executed on both MPS A and MPS B servers.
1. MPS X: Log in to Login: root
(1 | T | the server as the user Password: <root_password>

“I’OOt”

2. Olo MPS X: Switch user | # su - platcfg
to platcfg.
4| Main Menu Ii
Select “Server

T 2
Configuration” Menu AT T ETET

Diagno=stics

Remote Consoles
Hetwork Configuration
Security

Exit

3. MPS X:

Select “Hostname” 4 Server Configuration Menu F
Menu

Hostname
Designation/Function
Configure Storage
Set Clock

Time Zone

Exit

4. MPS X: Change the | gelect Edit and press [ENTER
L1 [ O | host name. P [ ]
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Set the Hostname as —| options ——

“Ismspri” on Server
A and as “Ismssec”
on Server B and
press “OK”.
Select OK and press [ENTER].
Note: While connected to the serial console, some console output might come
when the user is using the serial console to configure the LSMS. Those serial
output are harmless and can be ignored.
5. MPS X: ' e ;
O Hostname Configuration
Verify that the
Hostname is correct
then select and press
“Exit”.
. Current Hostname: Smspr
Otherwise repeat the current HoSCname lsmspri
step above.
6. MPS X: Navigate t0 | Select Designation/Function and press [ENTER]

the Designation
Information screen.

Full Upgrade for LSMS 13.2
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—| Server Configuration Menu I—

Hostname

Set Clock
Time Zone
Exit

10 MPS X:

1) Select “Edit”
from the options
dialogue box.

2) Set the
Designation as “1A”
on Server A and as
“1B” on Server B,

. — ] Edit Designation —————
Function as “LSMS - esignation
and press “OK”.

Designation:
Function:

NOTE:

Designation and
Function should be
entered in
UPPERCASE.

8. MPS X:

Verify that the
Designation and
Function is correct _ ) )
then select and press Designation:
U] | O “Exit”. Function:

Designation Information

Otherwise repeatthe | '—1 Gpeions F——

step above.
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MPS X: Exit the
platcfg menu

NOTE:
DO NOT set the

The time zone will
be set later in initial
configurations.

time zone in platcfg.

Select Exit and press [ENTER] to return to the Main Menu.
Server Configuration Menu

Hostname
Designation/Function
Configure Storage
Set Clock

Time Zone

Select Exit and press [ENTER]. The “platcfg” utility terminates.
Main Menmu |——

Maintenance
Diagnostics

Server Configuration
Eemote Consoles
Hetwork Configuration

This procedure is complete!

Procedure 10 -

INSTALL THE LSMS APPLICATION

Procedure 10 - Install the LSMS Application

This procedure installs the application on the server.
Estimated time: 25 minutes

Note : Below procedure needs to be executed on both MPS A and MPS B servers.

Rl om-on

MPS X: Log into
console the server as
the user “root”

Console Login: root
Password: <root_password>

MPS X: Perform
Procedure in 3.6A.1
or copy LSMS
13.2.X 1SO to
Ivar/TKLC/upgrade
directory.

MPS X: Start
platcfg utility by
logging in as platcfg
user.

# su - platcfg
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4. MPS X: Early The platcfg Main Menu appears.

O d .
upgrade checks On the “Main Menu”, select Maintenance and press [ENTER].

— Main Menu |——

Diagnostics

Server Configuration
Remote Consoles
Network Configuration
Security

Exit

Select the “Upgrade” menu and press [ENTER].

————1 Maintenance Menu F—————

Backup and Restore

View Mail Queues

REestart Server

Save Platform Debug Logs
Exit

Select the “Early Upgrade Checks” menu to verify that the system is ready for
upgrade.

—| Upgrade Menu ———

Validate Medis

Early Upgrade Checks %
Initiate Upgrade

Copy USE Upgrade Image
Non Tekelec RPM Hanagement
Exit

Select the desired upgrade media and press [ENTER].

I Choose Upgrade Media Menu |

If the Early Upgrade Checks fail due to the ongoing syncing of raid mirrors, then
follow the steps 5 and 6 to ignore the disk mirroring before the LSMS installation. If
the Early Upgrade Checks passed then jump to Step 7.
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Early Checks failed for the next upgrade

Look at earlyChecks.log for more info

tarting Early Upgrade Checks at 1011413059

Punning earlyUpgradeChecks () for Upgrade::EarlyPolicy::TPDEarlyChecks upgrade policy...
Verified serwver is not pending accept of previous upgrade

ERROR: Raid mirrors are syncing!

ERROFR: mdi is syncing!

ERROR: earlyUpgradeChecks() code failed for Upgrade::EarlyPolicy::TPDEarlyChecks
ERROER: Failed runnhing earlyUpgradeChecksi() code

Hardware architectures match

Install products match.

No Application installed yet.. 3kip alarm check!

ERRCOR: Early Upgrade Checks Failed!

User has requested just to run early checks.

MNo upgrade will ke performed...

Early Upgrade Checks finished at 1011413059

[adwusrlepappri ~]§ cat fproc/mdstat

Personalities : [raidl]

mdl : active raidl sdbZ[1] sdaZ[0]
262080 blocks super 1.0 [2/2] [UU

md2 @ active raidl =sdal[0] sdbil[1]
4658447232 blocks super 1.1 [2/2] [UU]
[E====>.. . iiiieinn 1 resyne = 29.7% (139377920/465447232) finish=73.0wmin sSpeed=75060K/=se
bitmap: 4/4 pages [16KB], 65536KE chunk

unused devices: <nonex>

Contact My Oracle Support following the instructions on the Appendix E, if the early
upgrade checks fail due to any other reason.

5. MPS X: Exit the
O d platcfg menu

Select Exit and press [ENTER] to return to the Maintenance Menu.

4| Upgrade Menu Ii

Validate Media

Early Upgrade Checks
Initiate Upgrade

Copy USE Upgrade Image
Non Tekelec EPM Management

Select Exit and press [ENTER] to return to the Main Menu.
Maintenance Menu

Upgrade

Backup and Bestore

View Mail Queues

Restart Server

Save Platform Debug Logs

WRIEE R

Select Exit and press [ENTER]. The “platcfg” utility terminates.
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—] Main Menu —

Maintenance
Diagnostics

Server Configuration
Security

Network Configuration
Remote Con=soles

6. MPS X: Ignore disk
O d mirroring before
LSMS installation

# echo "IGNORE_EARLY_CHECKS=1" >
/var/TKLC/Tog/upgrade/tmp_upgrade.conf

verify:
# cat /var/TKLC/log/upgrade/tmp_upgrade.conf
IGNORE_EARLY_CHECKS=1

MPS X: Validate
the upgrade media

Use the “Arrow”
and the [ENTER]
keys to navigate the
Menu options as
shown to choose the
upgrade media.

On the platcfg “Main Menu”, select Maintenance and press [ENTER].

Menu |—

Server Configuration
Remote Consoles
Network Configuration
Security

Exit

————4 Maintenance Menu F—————

Backup and Restore

View Mail Queues

Restart Server

Save Platform Debug Logs
Exit
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Press any key to
return to the menu
and then press Exit
all way back to the
Maintenance Menu

4| Upgrade Menu Ii

Validate Media

Early Upgrade Checks
Initiate Upgrade

Copyv USE Upgrade Image
Non Tekelec RPM Management
Lecept Upgrade

Reject Upgrade

Exit

I Choose Upgrade Media Menu

fmedia/sdel/TPD.install-7.0.3.0.0 86.44.0-0Oraclelinux6.7-%86 64.iso0 - 7.0.3.0.0 86.44.0

Exit

The results of the validation will be displayed, similar to the
example below.

Press the “enter” key to continue.

8. MPS X: Navigate to
the Initiate Upgrade
menu.

Use the “Arrow”
and the [ENTER]
keys to navigate the
Menu options as
shown to choose the
upgrade media.

Select the Initiate Upgrade menu and press [ENTER)].

———————{ Upgrade Menu F————————

Validate Media

Early Upgrads Checks
Initiate Upg 3

Copy USB Upgrade Image

Non Tekelec RPM Management
Accept Upgrade

REeject Upgrade

Exit

The screen displays a message that it is searching for upgrade media. When the
upgrade media is found, an Upgrade Media selection menu appears similar to the
example below.
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Select the desired upgrade media and press [ENTER].
|

| Choose Upgrade Media Menu |

6 64.is0 - 7.0.3.0.0 56.44.0

0.0 §6.44.0-0Oraclelinuxs.7-

O MPS X:
Upgrade proceeds

The screen displays the output like following, indicating that the upgrade software is
first running the upgrade checks, and then proceeding with the upgrade.

No Application installed yet.. Skip alarm check!
Verified all raid mirrors are synced.

Early Upgrade Checks Have Passed!

Early Upgrade Checks finished at 1447429031
Initializing upgrade information...

Many informational messages appear on the terminal screen as the upgrade proceeds.
The messages are not shown here for clarity sake. When installation is complete, the
server reboots.

10.

0 MPS X: Upgrade
completed

After the final reboot, the screen displays the login prompt as in the example below.

1462266947 Upstart Job TKL Csnmp-subagent: started

EY PPy IL PRy FX PE R Ny FE P A8 FI g dy FY PRIy Id§T
LA I A o e b i B

1462266947 Upstart Job syscheck: started
HEHHFFHHEERR SRR

1462266947 Upstart Job tpdProvd: started
BEHHATHHERR AR AR

1462266949: Upstart Job ntdMgr: started
B S e

Oracle Linux Server release 6.7
Kemnel 2.6.32-573.18.1.el6prerel7.0.3.0.0_86.44.0.x86_ 64 on an x86_64

lsmspri login:

11.

[ MPS X:
Login as root user.

Login: root
Password: <root_password>

12.

MPS X :

Check the upgrade
and warnings

# grep "Up?r‘ade returned success"
/var/TKLC/Tog/upgrade/upgrade.log
1248284646:: Upgrade returned success!

# grep -i error /var/TKLC/log/upgrade/upgrade.log
1466151711::ERROR: Raid mirrors are syncing!
1466151711::ERROR: md2 is syncing!

1466151711: :ERROR: earlyuUpgradeChecks() code failed for
Upgrade: :EarlyPolicy: :TPDEarlyChecks

1466151711::ERROR: Failed running earlyUpgradecChecks() code
1466151711::Ignoring errors as requested by
TIGNORE_EARLY_CHECKS. ..

Theses errors would be expected if user ignores early upgrade check.

# grep -i error /var/TKLC/log/upgrade/ugwrap.log
There should be no error output.

# grep -i warning /var/TKLC/1og/upgrade/upgrade.log
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The folTowing warning are expected:

5422101919::WARNING: Source file does not exist...cannot get

iff!

1448101919: :WARNING: TKLCIsms-Config-1.4.4-13.2.0.0.0_132.8.0:

Current hostname "Tsmspri" being reset to default.
1448101919: :WARNING: SOURCE: /var/lib/misc/prelink.force

é4$§101919::WARNING: Source file does not exist...cannot get
iff!

1448101919: :WARNING: SOURCE: /etc/sysconfig/ntpdate

5422101919::WARNING: Source file does not exist...cannot get
iff!

1448101920: :WARNING: SOURCE: /etc/sysconfig/network-
scripts/ifcfg-eth03

5422101920::WARNING: Source file does not exist...cannot get
iff!

1448101920: :WARNING: SOURCE: /etc/sysconfig/network-
scripts/route-eth0l

5412101920::WARNING: Source file does not exist...cannot get
iff!

1448101920: :WARNING: SOURCE: /etc/sysconfig/network-
scripts/ifcfg-eth02

é4$%lOl920::WARNING: Source file does not exist...cannot get
iff!

1448101920: :WARNING: SOURCE: /etc/sysconfig/network-
scripts/ifcfg-eth04

é4$%lOl920::WARNING: Source file does not exist...cannot get
iff!

1448101920: :WARNING: SOURCE: /etc/sysconfig/network-
scripts/ifcfg-eth0l

é4$%lOl920::WARNING: Source file does not exist...cannot get
iff!

1448101920: :WARNING: SOURCE: /etc/ntp/crypto/pw
é4$§lOl920::WARNING: Source file does not exist...cannot get
iff!

1448101920: :WARNING: SOURCE: /etc/rc.d/init.d/jexec
é4$%lOl920::WARNING: Source file does not exist...cannot get
iff!

1448101920: :WARNING: SOURCE: /etc/php.d/soap.ini
3422101920::WARNING: Source file does not exist...cannot get
iff!

1448101921 : :WARNING: SOURCE:
/etc/.java/.systemPrefs/.systemRootModFile
3422101921::WARNING: Source file does not exist...cannot get
iff!

1448101921 : :WARNING: SOURCE:
/etc/.java/.systemPrefs/.system.Tock

3422101921::WARNING: Source file does not exist...cannot get
iff!

1448101921 : :WARNING: SOURCE: /etc/udev/rules.d/90-dm.rules

13. MPS X:

Verify LSMS
release.

# rpm -qi TKLClsms

Hame : TELClsms Relocations: (not relocatable)

Version = 13.31.0 Vendor: Tekelec

Eelease : 13.2.0.0.0_132.7.0 Build Date: Fri 06 May 2016 05:25:35 PM GM|
T

Install Date: Tue 10 May 2016 11:24:22 AM GMT Build Host: diablo-9.tekelec.com
Group : TELC/Application Source RPM: TKLClsms-13.31.0-13.2.0.0.0_ 13
2.7.0.src.rpm

Size : 21TBEZ395 License: § TEEELEC 2004-2016

Signature : (none)

Packager : <0pen Systems>

TURL : http://www.tekelec.com/

Sunmary : Cracle Communications LSM3 Package

Description :

This iz the Oracle Communications LSMS Package. The package installs LSMS software.
Local Service Management System (LSMS5) is a secure and reliable
Local Humber Portability (LNP) system.

This procedure is complete!
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Full Upgrade for LSMS 13.2

CONFIGURE NETWORK INTERFACE USING PLATCFG UTILITY

Hetwork Configuratio

Eempte Consoles
Exit

4 Network Configuration Menu F

SHMMP Configuration
Routing

Configure Hetwork
Hetwork EBridges
Iptables

IPSEC Configuration
Re=zolvw

Stunnel

Modify Hosts File
Configure Switch
Exit

? This procedure configures the network interfaces and makes the ESAPPB servers accessible to the network.
E | B [ Estimated time: 5 minutes
P
#
. Console Login: root
1O | MPsX: Password: <root password>
Login as root
user.
> | O] mes x: # su - platcfg
Login to
platcfg utility
3. D MPS X: 4| Main Menu Ii
Conﬂgum Maintenance
Network ) .
Diagnostics
Interface . .
Server Configuration
Security
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4 Hetwork Interfaces Menu F

Add an Interface

Edit an Interface

Delete an Interface
Exit

4 Connection to edit Menu F

ethi2
ethi3
eth03.1
eth03.3
ethi4
Exit

4| 11| mPsx:

Select
Interface
Options

MTU:

[ } on

GRO: off
<undef>

o

eiol il (%) off
<undef>
BootProto:

Full Upgrade for LSMS 13.2

45 of 92




Software Upgrade Procedure

Procedure 11 — Configure Network Interfaces using platcfg utility

Full Upgrade for LSMS 13.2

—I Configure Ethtool Options I—

Would you like to configure Ethtool COptions?

{ Configure IFP Address I

Would you like to configure IP addresses?

IPvE
Exit

4 Chooze IP Address Version Menu

Choose Address Lction:

—| Choose IPv4 Rddress Action b———

{(*) Add Address

{ }» Edit

5.1 ]| MPS X:

Input the
Interface
Address

IP Address:
Netmask:

Start on Boot:
Live:

— | =dit IPv4¢ Interface —————
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Select “Exit” until you exit from the platcfg utility.

6. | 1| MPSX:

Configure
default route.
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I IPvd4 Static Routes I

Interface Type iddreszs Netmask

ethil default default 10.250.51.1

4 IPv4d RBoute Action Menu F

Ldd Foute

Edit Route
Delete Route

Policy Based Routing
Exit
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Device:

Gateway:

—{ Add default Route [———

bhondd
bhondd.
bondd. 3

Select “Exit” until you exit from the platcfg utility.

3.5Initial Configuration

Procedure 12 - LSMS INITIAL CONFIGURATION

Procedure 12 - LSMS Initial Configuration

Estimated time: 15 minutes

This procedure does the initial configuration on the LSMS servers.

MPS A: Log in to the server as the
user “root”.

DH *OMmM—A®

Login: root
Password: <root_password>
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2. | MPS A: # su - Ismsmgr
O] start Ismsmgr utility by logging in as
Ismsmgr user

3. | MPS A:
] ——{ Main Menu |—
Select “Initial Configuration” e —

Maintenance
Diagnostics
Server Configuration
Hetwork Configuration
Exit

4. | MPS A:

] —] Select running options |—

Select “yes”

Select OK and press [ENTER]

5. | MPS A:
] - Query for FirstTimeConfig::010EKeyExchange |

Enter root password: _

Enter password for “root”

Select OK and press [ENTER]

6 MPS A: - fuery Ifor FirstTimeConfig: :01ZAdmFeyExchange [

Enter lsmsadm password: _

Enter password for “Ismsadm”

Select OK and press [ENTER]
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7. MPS A: —| Cuery for FirstTimelonfig: :013RoothdmlUsrEeyExchange |—

L]
Enter admusr password: _

Enter password for “admusr”

Select OK and press [ENTER]
3. MPS A ——————————— Query for FirstTimeConfig::05BackupConfig —————
I:l Enter the NAS root password for NAS configuration:: _

Enter path to NAS console device:: s f 2

Enter the NAS password used to

login into NAS console. Accept the

default serial port (ttyS2) when

prompted for the path to the NAS

console device.

Select OK and press [ENTER]

9. | A message is displayed indicating the root Key Exchange was successful.

A message is displayed indicating the Ismsadm Key Exchange was successful.

A message is displayed indicating the admusr Key Exchange was successful.

A message is displayed indicating the Time Synchronization was successful.

A message is displayed indicating the Database creation was successful.

A message is displayed indicating the NAS Backup Configuration was successful.
A message is displayed indicating the inhibiting of the node was successful.
Select Exit and press [ENTER] repeatedly to exit Ismsmgr

10. | MPS A: #ssh mate
C| switch to mate

11.| MPS B: # su - Tsmsmgr
U Start Ismsmgr
12.| MPS B: ——] Main Menu |——
Ll
Maintenance
Diagno=stics

Select “Initial Configuration”

Server Configuration
Hetwork Configuration
Exit
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13.| MPS B: —] Select running options |——
U Select “yes”
Select OK and press [ENTER]
14. MPS B ——————————— Query for FirstTimeConfig::05BackupConfig —————
I:l Enter the NAS5 root password for NAS configuration: _
Enter path to NAS console device: 2
Enter the NAS password used to
login into NAS console.
Select OK and press [ENTER]
1& A message is displayed indicating the Database creation was successful.
A message is displayed indicating the NAS Backup Configuration was successful.
Select Exit and press [ENTER] repeatedly to exit Ismsmgr
16.| MPS B: # minicom mate
O Log into the LSMS B server via
minicom.
17.1 MPS A: #init 6
L| Perform init 6 to reboot the LSMS B
card. Watch for errors during boot process.
When the login prompt is displayed, exit from minicom.
18.| MPS A: # minicom mate
O Log into the LSMS A server via
minicom.
19.| MPS B: # 1nit 6
L] perform init 6 to reboot the LSMS A | Watch for errors during boot process.

card.

When the login prompt is displayed, exit from minicom.

This procedure is complete!
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? This procedure configures the time zone and clock.
g | Estimated time: 5 minutes
Z Note: Below procedure needs to be executed on both MPS A and B servers.
1. | MPS X: Log intothe | Login: root
1 | server as the user Password: <root_password>
“root”.
MPS X: Start # su - lsmsmgr
2| Ismsmgr utility by
[ logging in as
Ismsmgr user.
MPS X:: Verify time | Select Server Configuration and press [ENTER].
3|'-:| 70Ne. ——] Main Menu |——
Initial Configuration
Maintenance
Diagnostics

Server Configuration
NHetwork Configuration
Exit

Select Time Zone and press [ENTER].
- Server Configuration Menu |

Set Clock

ime Zone

Exit

The screen shows the current time zone setting.

x

[maggqagggaaagaaqaaqaal

If this is not correct, select Edit and press [ENTER].

If the time zone is correct, select Exit, press [ENTER] and skip the next step

‘llj MPS X: Change time | Select appropriate time zone and press [ENTER].
zone.
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lggggggu Select Time Zone Menu tggggggk

hmerica/Mazatlan
hmerica/Mendoza
hmerica/Menominee
bmerica/Merida
hmerica/Metlakatla
merica/Mexico City
America/Migquelon
America/Moncton
America/Monterrey
America/Montevideo
America/Montreal
America/Montserrat
bmerica/Nassau

oo

ca/New York
America/Nipigon
bmerica/Nome
hmerica/Noronha

[ I U T U T
A A A A R

L T T

il {o (o o o {o (o (o o o (o o o (o (o o o o o o o (o o o o (o o o o o o o (o o e o

Select Yes to set the hardware clock to GMT and press [ENTER].
lggogoggagagou Time Zone tggggagqaggagk

= =
® Set hardware clock to GMT? b4
= =
= Lagggagkil]l gaog k.4
4 xlﬁﬂﬂlx x Ho = [
= ogagg] magog] Qe
= =
= =

i1l fu fu o (o (o fw g g (o Lo o s f o o o o o o s o o [ (o e o o i s

MPS X: Set clock. Select Set Clock and press [ENTER].
Server Configuration Menu

Set Clock

Time Zone
Exit

Select Edit and press [ENTER].
Oprtions
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Enter correct time.
—] Change Date and Time |—

'

Date:
Time:

Use right arrow to get to OK and press [ENTER].

6. MPS X: Exit the Select Exit and press [ENTER] to return to the Main Menu.
Bmsmgrnwnu Server Configuration Menu F

Set Clock
Time Zone

Select Exit and press [ENTER]. The “Ismsmgr” utility terminates.
Main Menu

Initial Configuration
Maintenance
Diagnostics
Server Configuration
Hetwork Configuration

This procedure is complete!

Procedure 14 - SINGLE SUBNET CONFIGURATION FOR LSMS MPS CARDS

Procedure 14 - Single Subnet Configuration for LSMS MPS Cards.

This procedure configures the system as single subnet at the customer site.
Estimated time: 10 minutes

UM ®
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MPS A: Log in to the

Login: root

1. server as the user Password: <root_password>
O “root”.
MPS A: Start # su - lsmsmgr
2. Ismsmgr utility as
[ Ismsmgr user.
MPS A: Change the | Select Network Configuration and press [ENTER].
3|':| network configuration

—{ Main Menu |——

Initial Configuration

Maintenance E
Diagnostics E
Server Configuration
Metwork Configuration E
Exit

Select Network Reconfiguration and press [ENTER].

- Network Configuration Menu |4

Metwork Reconfiguration
SHMP Configuration
Routing

NTIP

IPSEC Configuration
Modify Hosts File
Exit

Select Yes to proceed to Network configuration.
lggggggagagagaggggggu Network Reconfiguration tggggdgdgdgqoagagaadgk
-4

4
® WARNTHG: This action is service impacting. Are you sure? ®
4 -4
4 Logoakil agaoo ke
4 x No = :-::-: X
X mogagg] magagg] el
4

4

ﬂlﬂCICICICIC_IC[CICIClClCICICICICI_CICIC[C[C[CIClClCI_C[CICICICICIC[CIC[CI_CICIGCICICICICIUQQQQQQQGGGQUUQQQQQQQGG']
A lynx driven screen will appear with the following prompt;

Do you want to execute "/usr/TKLC/Isms/tools/IsmsnetAdm-bin/Ismsnetadm.cgi"?

Type “Y/y” to continue and the next screen will appear and press the right arrow key to
follow the link

Select Single from the Subnet Type menu and then select Continue.
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Continne

MPS A: Enter
network values.

Using the up and down arrows, scroll through the text fields, entering the desired values ( to
enter the netmask, highlight the field and then use the enter key or right arrow key to
display the dropdown menu, choose the desired value from the list) for each fields:

Humber: LE1632ABSS

IF: 192.168.59.30 Netmask: [255.255.255.0 ]

IF: 192.168.59.31

Hetmask: [255.255.255.0 ]

' 192.168.59.32

-168.59.250

-10

Start Over

Once the values are entered press the down arrow to select the “Submit” button and press
the right arrow to follow the link.

Note: The System Number shall be as follows:
o LEYYWWMMXX
o  Where:
o LE is the new System Number Prefix for LSMS.
oYY = YEAR - year of the system shipment
o WW= WEEK - calendar week of the Y'Y year when the system is
shipped
o MM = MANUFACTURER (if other than TKLC) — Here 00 as
Manufacturer is Oracle
o XX =number in line of systems shipped that week
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MPS A: Apply If the values pass a sanity test for validity, then the “Confirm” button will be visible. Use

network settings the down arrow to select “Confirm” and press the right arrow to apply the changes. If the
sanity tests failed, the reasons will be stated. Use the left arrow key to go back to the edit
screen.

The execution could take a few minutes, be patient. The screen will eventually report the
status of the completion. If an error occurs, contact My Oracle Support following the
instructions on the Appendix E.

Type “q” and then “y” to exit the Network Configuration.

Aelmin

TEM NUN LE11111111
4 single
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Software Upgrade Procedure

onfiguration for LSMS MPS Cards.

MPS A: Exit the Se

5 Ismsmgr menu =

[l

lect Exit and press [ENTER] to return to the Main Menu.
Hetwork Configuration Menu F

Hetwork Reconfiguration
SHMP Comfiguration
Routing

HTP

IPSEC Configuration

Se

lect Exit and press [ENTER]. The “platcfg” utility terminates.
Main Menu

Initial Configuration
Maintenance
Diagnostics
Server Configuration
Network Configuration

This procedure is complete!

Procedure 15 - SEGMENTED CONFIGURATION FOR LSMS CARDS

Procedure 15 - Segmented Configuration for MPS LSMS Cards

S | This procedure configures the system as segmented subnet at the customer site.
E Estimated time: 10 minutes
P
#
1. | MPS A: Log in to the server| Log1n: root
O as the user “root”. Password: <root_password>
2. | MPS A: Start Ismsmgr # su - Ismsmgr
] utility by login as Ismsmgr
user
3. | MPS A: Change the Select Network Configuration and press [ENTER].
[ network configuration
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——] Main Menu [—

Initial Configuration

Maintenance E
Diagnostics =
Server Configuration

Metwork Configuration E

Exit

Select Network Reconfiguration and press [ENTER].

- Hetwork Configuration Menu |

Hetwork Reconfiguration
SHMP Configuration
Routing

HTE

IPSEC Configuration
Modify Hosts File

Exit

Select Yes to proceed to Network configuration.

lgggggaaaaggaaaagggau Network Reconfiguration tgggggoaooaaaaaaadd
x

WABRNING: This action is service impacting. Are you sure?
1 agoqod 1. qqqqq]ﬂ,
x HNo x xliﬂiﬂlh

mogag] magggg]

MoM oMM MMM

mﬂﬂGGGUqUUGGGGGGGGFUUUUGGqﬂgﬂﬂGGUUUUGgGGGGGGGGUUUGGGGGGGGGGUUUUGC
A lynx driven screen will appear with the following prompt;

Do you want to execute "//usr/TKLC/Isms/tools/IsmsnetAdm-
bin/lsmsnetadm.cgi"?

Type “Y/y” to continue and the next screen will appear and press the right arrow
key to follow the link

Select Segmented from the Subnet Type menu and then select Continue.

n will cause a service interroption!

Continue

MPS A:
Enter network values.
]

>

Using the up and down arrows, scroll through the text fields, entering the desired
values ( to enter the netmask, highlight the field and then use the enter key or right

ok

L

oo
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arrow key to display the dropdown menu, choose the desired value from the list)
for each fields:

P Pingable Ga

n Nomber: LE11111111

192.168.60.250
': 192.168.60.3 1 [255.255.255.0 ]

v NPAC TP: 192.168.60.4 Netmask: [255.255.255.0__ ]

Network

192.168.59.250
v APP IP: 192.168.59.3

v APP IP:

192.168.59.4 Het k:[255.255.255.0 ]

’: 192.168.59.5

Network

v EM5 IP: 192.168.61.38 ask: [255.255.255.0 ]

EMS IP: 192.168.61.51 H k:[255.255.255.0__

IF: 192.168.59.250

: 10.250.32_.10

Start
Submi t]

Note:

The System Number shall be as follows:

LEYYWWMMXX
Where:
o LE is the new System Number Prefix for LSMS
oYY = YEAR - year of the system shipment
o WW=WEEK - calendar week of the Y'Y year when the system
is shipped
o MM = MANUFACTURER (if other than TKLC) — Here 00 as
Manufacturer is Oracle
o XX =number in line of systems shipped that week

*Default route should be the route of the APP IP address.
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Once the values are entered press the down arrow to select the “Submit” button
and press the right arrow to follow the link.

MPS A: Apply network
settings
O ™

b

If the values pass a sanity test for validity, then the “Confirm” button will be
visible. Use the down arrow to select “Confirm” and press the right arrow to apply
the changes. If the sanity tests failed, the reasons will be stated. Use the left arrow
key to go back to the edit screen.

ion will cause a service interruption'!

Start Over

The execution could take a few minutes, be patient. The screen will eventually
report the status of the completion. If an error occurs, contact My Oracle Support
following the instructions on the Appendix E.

Type “q” and then “y” to exit the Network Configuration.
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Procedure 15 - Segmented Configuration for MPS LSMS Cards

Acmin

M NUM = LE11111111
s incle

Performing r
Performing 1

MPS A: Exit the Ismsmgr | seject Exit and press [ENTER] to return to the Main Menu.
[ menu | Network Configuration Menu

>

Network Reconfiguration
SHMP Comfiguration
Routing

HTE

IPSEC Configuration
Modify Hosts File

Select Exit and press [ENTER]. The “platcfg” utility terminates.
Main Menu

Initial Configuration
Maintenance
Diagno=stics

Server Configuration
Hetwork Configuration

This procedure is complete!

Procedure 16 - TMN TOOLKIT AND MARBEN OSI LICENSE INSTALLATION
Note: Valid Licenses need to be installed on both A and B LSMS servers.
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Contact NE Technologies Inc. to get a valid license file by providing
1. host name, Ismspri for A and Ismssec for B; and
2. Mac address for Ethernet interface eth01 (interface name after IPM’ed but before LSMS installation) or
eth0 (interface name after LSMS installation).

Procedure 16 - TMN Toolkit and Marben OSI License Installation

? This procedure will install the TMN Toolkit and Marben OSI License to both A and B LSMS servers.
E
P Estimated time: 5 minutes
#
1. MPS X: Logintothe | Login: root
server as the user “root” Password: <root_password>
| O
2. MPS X: Install the Copy the TMN Toolkit license file to /usr/local/netech/etc/license path following any steps
Ol O TMN toolkit license file| mentioned in 3.6C.1 or 3.6C.2
3. MPS X: Install the
D D Marben OSI License Copy Marben OSI License string using below command:
file # echo "<Marben 0SI license string>" > /usr/TKLC/osi/conf/1icense
4. MPS X: Restart the Reboot the system to take effect
system
0o # reboot
This procedure is complete!
Procedure 17 - START LSMS SERVICES

Procedure 17 - Start LSMS services

S This procedure starts the LSMS services.
E Estimated time: 10 minutes
P
#
1 MPS A: Log into the | Login: root
‘ server as the user Password: <root_password>
D GGrOOt”-
) MPS A: # su - lsmsmgr
0 Start Ismsmgr
3 MPS A: Start Node | On the “Main Menu”, select Maintenance and press [ENTER].
Ol - This will make node
active and start
application
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4| Main Menu Ii

Initial Configuration

Maintenance

Diagnostics

Server Configuration
Hetwork Configuration
Exit

Select Start Node and press [ENTER].
—4 Maintenance Menu

LSM5 Node Status

Start HNode

Stop Node

Inhibit Node
Backup and Restore
Exit

Select Yes to confirm node startup press [Enter]

4' Start Hode Ii

Confirm Node Startup

Select Exit and press [Enter] to return to Main Menu.
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Procedure 17 - Start LSMS services

—| Maintenance Menu |—

L5SMS5 Hode Statu=
Start Node

Stop Hode

Inhibit Hode
Backup and Restore

Select Exit and press [Enter] to exit the Ismsmgr menu.
— Main Menu

Initial Configuration
Maintenance
Diagno=stics

Server Configuration

Hetwork Configuration

- This will make node
standby and start
application

4 MPS A: #ssh mate

: Switch to mate
[
5 MPS B: Log in to the | Login: root

: server as the user Password: <root_password>
u “root”.
6 MPS B: # su - Tsmsmgr

Start Ismsmgr

7. MPS B: Start Node On the “Main Menu”, select Maintenance and press [ENTER].

Main Menu

Initial Configuration

Maintenance

Diagno=stics

Server Configuration
Hetwork Configuration
Exit

Select Start Node and press [ENTER].
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Procedure 17 - Start LSMS services

—4 Maintenance Menu F——

LSM5 Node Status

Start HNode

Stop Node

Inhibit Node
Backup and Restore
Exit

Select Yes to confirm node startup press [Enter]
4' Start Hode Ii

Confirm Node Startup

Press Enter once the node is uninhibited successfully.

Select Exit and press [Enter] to return to Main Menu.
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Procedure 17 - Start LSMS services

—| Maintenance Menu |—

LSMS Hode Statu=
Start Node

Stop Hode

Inhibit Hode
Backup and Restore

Select Exit and press [Enter] to exit the Ismsmgr menu.
—| Main Menu

Initial Configuration
Maintenance
Diagno=stics
Server Configuration
Hetwork Configuration

This procedure is complete!

Procedure 18 -

POST CONFIGURATION HEALTH CHECK

Procedure 18 — Post Configuration Health Check

F om-dw

This procedure determines the health of the Server after an installation. This procedure will perform a
syscheck on each LSMS server.

Estimated time:5 minutes

o -

MPS A and B: Log
in to the server as the
user “root”.

Login: root
Password: <root_password>

DE\’

MPS A and B:
Validate date, time and
time zone to ensure
accuracy.

# date
Thu May 12 05:55:27 EDT 2016

MPS A and B:

Execute the “hastatus”
command to verify the
HA state of this server.

Execute the following command on both LSMS A and B to verify the HA state of mated
LSMS pair.

# hastatus
Verify that the hastatus of one of the servers is Active and the other is Standby.
WARNING: If the output from the above command is anything else other than

“ACTIVE” and “STANDBY”, do not proceed with this procedure and contact My
Oracle Support following the instructions on the Appendix E.
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3.

[l

LSMS Standby server:
Verify that the
STANDBY server’s
MySQL replication is
functioning properly.

Execute the following command to verify that MySQL replication is working correctly
on the STANDBY LSMS server:

# tail /var/TKLC/Tsms/logs/dbrepiMon.Tog

If MySQL replication is functioning correctly then the following output will be
observed, make sure that at least the last line of your output matches the lines below.

Thu May 12 05:58:12 2016 A1l tests passed on STANDBY
FIPS integrity verification test failed.
FIPS integrity verification test failed.
Thu May 12 05:59:19 2016 A1l tests passed on STANDBY
FIPS integrity verification test failed.
FIPS integrity verification test failed.
Thu May 12 06:00:25 2016 Al1l tests passed on STANDBY
FIPS integrity verification test failed.
FIPS integrity verification test failed.
Thu May 12 06:01:32 2016 A1l tests passed on STANDBY

WARNING: If at least the last line of your output does not match the lines above then
do not proceed with this upgrade and contact My Oracle Support following the
instructions on the Appendix E.

>

MPS A and B:
Execute syscheck

# syscheck

disk...
OK
hardware. ..
OK
Tsmshc. ..
OK

Running modules 1in class

Running modules 1in class

Running modules 1in class

Running modules in class net...
OK
Running modules in class proc...
OK
services...
OK
system. ..
OK
upgrade. ..
OK

e LOG LOCATION: /var/TKLC/Tog/syscheck/fail_log

Running modules 1in class

Running modules 1in class

Running modules 1in class

LSMS Active server:

Capture the output of
‘sentry status’
command

Execute the following command on the ACTIVE LSMS server to display the current
LSMS sentry status:

# sentry status
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NOTE: Verify that the output displays a Status of “running” for all processes; the
regional processes (npacagents) may or may not be associated in the Comment field. If
the output from this command displays any other Status than “running” contact My
Oracle Support following the instructions on the Appendix E.

Capture the output from this command and make it available to Oracle Technical
Services if required.

This procedure is complete!

3.6 Data Migration

Procedure 19 -

Procedure 19 - Restore Database

RESTORE DATABASE

? This procedure restores the database on the LSMS server.
E | Estimated time:60 minutes
P
#
. Login: root
L. | MPS A server: Password: <root_passwords
[] | Log in to the server as the
user “root”.
2 | MPS A server: Transfergll thefNPACh: region DB snapshot files, supDB MySQL dump and users
[ | Copy the snapshot files MySQL dump from the Remote server to current LSMS A server.
from the Remote server to
the current LSMS Active Note: The NPAC regions are: CanadaDB, MidAtlanticDB, MidwestDB,
server. NortheastDB, SoutheastDB, SouthwestDB, WestCoastDB and WesternDB
# scp -p root@<rRemote IP>: <Remote IP Path>/mysql-snapshot-
<NPAC region>.tar.gz /var/TKLC/1sms/free
Password: <root_password>
# scp -p root@<Remote IP>:<Remote IP Path>/supDBdump.sql
/var/TKLC/1sms/free
Password: <root_password>
# scp -p root@<Remote IP>:<Remote IP Path>/
MySQLUserGrants.sql] /var/TKLC/1sms/free
Password: <root_password>
3. | MPS A and B server: . . .
Note: Execute this step on Standby LSMS server first followed by the active
] | Stop LSMS processes LSMS server.
# su - lsmsmgr
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Exit the Ismsmgr menu.

MPS A and B:

] | Execute the “hastatus”
command to verify the HA
state of this server.

e

Execute the following command on both LSMS A and B to verify the HA state of
mated LSMS pair.

# hastatus
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Verify that the hastatus of both the servers is ‘UNINITIALIZED "INHIBITED™.

WARNING: If the output from the above command is anything else other, do not
proceed with this procedure and contact My Oracle Support following the
instructions on the Appendix E.

MPS A server:

Extract the snapshot data
from the archive tar files
copied from LSMS.

# cd /var/TKLC/1sms/db

Restore the <regionDB> with the regional database name (For example:

CanadaDB)
# tar -xzvf /var/TKLC/1sms/free/mysql-snapshot-
<regionbDB>.tar.gz

o

MPS A server:

Restore supDB and MySQL
Users.

Execute the below commands:
# service mysql start

Restore the ‘supDB’
# mysql -udbroot -p[dbroot_password] supDB <
/var/TKLC/1sms/free/supDBdump.sql

Restore MySQL users
# mysql -udbroot -p[dbroot_password] <
/var/TKLC/1sms/free/MysSQLUserGrants.sql

# service mysql stop

Note: Below warning message can be ignored if displayed:
warning: Using a password on the command 1ine interface can
be insecure.

~

MPS A server:
Remove the snapshot files

Remove the snapshot files.

# cd /var/TKLC/1sms/free

# rm -f mysql-snapshot-*

# rm -f supbBdump.sql

# rm -f MySQLUserGrants.sq]l

®

MPS A server:

Check ownership of
database files

verify dbadm:dbadm ownership of all database files and
directories.

# cd /var/TKLC/1sms/db
# 1s -1tr <DB Name>

where <DB NAME> is supDB or <region>DB,
where <region> is the name of an NPAC region.

If any databases have ownership other than dbadm:dbadm, change them using
this command:

# chown -R dbadm:dbadm <DB NAME>

o

LSMS Active Server:

Make supDB schema
changes

Execute the below commands:

# service mysql start

Make supDB schema changes

Run the following script from the bin directory
# su - lsmsadm

# cd /usr/TKLC/lsms/bin
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# ./dbMigrationl3_2

Following would be the expected output :
AAKEAAKA AR A AR A A AR A AR R A A AR AAA R A AR AR AR RAAAR A AR AR AAA A AA A AAA A AAAhhhih ik

*hkhkhkkhkkkhkkhkkikkk
Caution!!! Please enter correct details below, otherwise DB might get corrupt
AEAAAKKAKAAAAAAAAAARAAAAAAAAA A AR A AAAAAAAAAAAAAAA AR A AR A A A A A A Ahhhhiik

*kkhkkhkkkikhkkk

Enter the LSMS source release for full upgrade (13.0/13.1): 13.0
INFO: supDB changes from LSMS 13.0 to LSMS 13.1 done successfully.
INFO: supDB changes from LSMS 13.1 to LSMS 13.2.X done successfully.

# exit
# service mysql stop

10. | MPS A and B server: . .
Note: Execute this step on LSMS A server first followed by LSMS B server.
[] | Start LSMS processes
# startNode
11. | MPS A and B: .
Execute Procedure 17 - to verify the system health check after DB full upgrade.
] | System Heath Check
12. | LSMS Active server: . .
. Login to LSMS Active GUI as Ismsall user.
[] | Login to LSMS GUI
13. | LSMS Active server: .
. Refer to the recorded value of MySQL Port in 23Procedure 6 - step 10.
[ | Configure MySQL Port If the MySQL Port is default port, then skip the next step.
Otherwise, go to “Admin -> MySQL Port -> Modify” and configure the port
recorded from LSMS 13.0/13.1.
14. | LSMS Active server: . .
. Go to “Configure -> LNP System -> EMS -> View” to verify the ELAP
[ greg('jfgn:?;sELAP Credentials are identical to the recorded value of the ELAP Credentials in

Procedure 6 - step 11.

Otherwise, go to “Configure -> LNP System -> EMS -> Modify” and configure
the ELAP Credentials recorded from LSMS 13.0/13.1.

This procedure is complete!

Procedure 20 -

CONNECT LSMS 13.2.X TO NPAC

Procedure 20 - Connect LSMS to NPAC

H O m-+Hw

This procedure connects the LSMS to the NPAC.

Estimated time:15 minutes

NOTE: Execute this procedure only when the NPAC region is not visible on the LSMS GUI, after the DB is restored.
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[] | Verify LSMS installation ) ] ]
1. LSMS 13.2.X is successfully installed and configured.
2. NAS is successfully installed and configured.
2. | LSMS Active server: . )
7 | Login to LSMS Active GUI Login to LSMS Active GUI through VIP as Ismsall user.
3. | LSMS Active server: . .
[ | Update NPAC Customer ID | Click on the NPAC region. _
Go to the menu Configure -> LNP System -> LSMS -> Modify
Enter the new LNP SPID in the ‘NPAC Customer ID’ field and fill appropriate
information in all other fields.
Madify LNP Systern LSMS [
MPAC Custamer 1D
l/ Component Info rCorItac‘l Info |
System Type LEMS Owner ID THLC
Platform Type LSMS Platform Supplier |2racle
Platform SWWRelease |13.2 Platform Model 1.0
EI Modify LSMS Component?
| OK || Cancel
4. | LSMS Active server: . ]
[] | Create NPAC region(s) and | Click on the NPAC region. _ _
connect it to the NPAC Go to the menu Configure -> LNP System -> NPAC -> Modify -> Primary
Enter the NPAC IP in the ‘NSAP’ field and NPAC FTP Address and check the
‘Activate Region’ checkbox. Fill the information in all other tabs.
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i Modify LNP Systern NPAC <MidAtlantic, primary> (25

SMS Name |Mid-Aflantic Regional MPAC SMS

Address Info Component Info Contact Info Comm Info

MPAC OS5 Address

v| Activate Region

PSEL |owl SSEL |owl TSEL MSAP |10 248 (10 |5

Lims O8] Address

PSEL psel 55EL ssel TSEL MN3&F 10 248 10 FE

MPAC FTP Address

10 |248 |10 |5

E Modify NPAC Component?

Ok Cancel

This procedure is complete!

Procedure 21 -
SERVER

EXPORT THE DATABASE FROM LSMS 13.2.X TO THE QUERY

Procedure 21 — Export the Database from LSMS 13.2.X to the Query Server

H UOTm-4Hw

This procedure provides the steps to export the database from the LSMS 13.2.X system to the query server.
Estimated time:30 minutes

LSMS Active server:
[] | Login as root.

Ju—

Login to LSMS 13.2.X CLI as root user.

LSMS Active server:

] | Remove the existing DB
snapshot files

N

# rm /var/TKLC/lsms/free/mysql-snapshot-*
# rm /var/TKLC/lsms/free/snapinfo.sql

3. LSMS Active server:
[] | Create a snapshot

# 1smsdb -c snapshot

WARNING: This command may cause a brief interruption in
traffic being sent

from the NPAC to connected network elements and Tocal LSMS
provisioning may be INTERRUPTED.

Do you want to continue? [Y/N]Y

Creating snapshot of the database partition, please wait...
lvcreate -- WARNING: the snapshot will be automatically
disabled once it gets full

lvcreate -- INFO: using default snapshot chunk size of 64 KB
for "/dev/vgapp/dbbackup”

lvcreate -- doing automatic backup of "vgapp"

lvcreate -- logical volume "/dev/vgapp/dbbackup"
successfully created
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The database 1s available to the application again.
Disk snapshot created successfully.

mount: block device /dev/vgapp/dbbackup is write-protected,
mounting read-only

Snapshot mounted successfully.

Created snapinfo.sql file successfully

CanadaDB/

CanadabB/db.opt

CanadaDB/Subscriptionversion.frm
CanadabDB/Subscriptionversion.MYI
CanadabDB/Subscriptionversion.MYD
CanadabDB/NumberpPool1Block. frm
CanadaDB/NumberpPoolBlock.MYI
CanadaDB/NumberpPoo1Block.MYD
CanadaDB/ServiceProvNetwork.frm
CanadaDB/ServiceProvNetwork.MYI
CanadaDB/ServiceProvNetwork.MYD
CanadaDB/ServiceProvLRN. frm
CanadaDB/ServiceProvLRN.MYI

EEruncated )
Tvremove -- doing automatic backup of volume group "vgapp"
Tvremove -- logical volume "/dev/vgapp/dbbackup"

successfully removed

b

LSMS Active server:
Verify the snapshot

# cd /var/TKLC/1sms/free

[root@Ismspri freel# 1s
mysql-snapshot-SouthwestDB.tar.gz
mysqgl-snapshot-supDB.tar.gz
mysql-snapshot-CanadaDB.tar.gz
mysqgl-snapshot-westCoastDB.tar.gz
mysql-snapshot-MidAtlanticDB.tar.gz
shapinfo.sql
mysqgl-snapshot-MidwestDB.tar.gz
mysqgl-snapshot-NortheastDB.tar.gz
mysqgl-snapshot-SoutheastDB.tar.gz

LSMS Active server:

Copy snapshot files to
LSMS 13.2.X Query Server
or a Remote Server.

Transfer all the NPAC region DB snapshot files.

Note: The NPAC regions are: CanadaDB, MidAtlanticDB, MidwestDB,
NortheastDB, SoutheastDB, SouthwestDB, WestCoastDB and WesternDB

# scp -p /var/TKLC/1sms/free/mysql-snapshot-<NPAC
region>.tar.gz root@<Query Server IP>:/usr/mysqll

# scp -p /var/TKLC/1sms/free/snapinfo.sq] root@<Query
Server IP>:/usr/mysqll

or

# sftp <username>@<IP address of remote computer>
Connecting to <IP address of remote computer>...

The authenticity of host '<IP address of remote computer>'
can't be established.

DSA key fingerprint is
58:a5:7e:1b:ca:fd:1d:fa:99:f2:01:16:79:d8:b4:24.

Are you sure you want to continue connecting (yes/no)? yes
warning: Permanently added '<IP address of remote computer>'
(DSA) to the 1ist of known hosts.

<username>@<IP address of remote computer>'s password:

sftp> cd <target directory>
sftp> put mysqgl-snapshot-<NPAC region>.tar.gz
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Uploading mysq/-snapshot-<NPAC region>.tar.gz
sftp> put snapinfo.sql

Uploading snapinfo.sql

sftp> bye

DP\

LSMS 13.2.X Query
Server:

Login as root to the Query
Server

login: root
Password:<root_password>

# cd /opt/mysql/mysql/bin

Extract the data for EACH
region. Replace regionDB
with regional database name

Remove each tar.gz after it
has extracted.

7. | LSMS 13.2.X Query
[] | Server: # ./mysqladmin -u root -p shutdown
Shutdown the Mysgl server | Enter password:
8. | LSMS 13.2.X Query # cd Jusr/mysqll
] Server: # gunzip -c mysql-snapshot-<regionDB>.tar.gz | tar -xvf -

# rm mysql-snapshot-<regionDB>.tar.gz

intermediate tarballs from
the LSMS 13.2.X server.

As the root user, remove the
snapinfo.sql script from the
LSMS 13.2.X server

9. | LSMS13.2.X Query # cd /opt/mysql/mysql/bin
] Server:
Start the Mysgl daemon on
the Query Server. TZ ./mysqld_safe --skip-slave-start &
55
# Sstarting mysqld daemon with databases from /usr/mysqll:
10. | LSMS 13.2.X Query # ./mysql -u root -p
] Server:
Start the Mysgl command
line utility mysql> reset master;
Query OK, 0 rows affected (0.23 sec)
Reset the configuration
information for master
mysql> reset slave;
Query OK, 0 rows affected (0.19 sec)
Reset the configuration
information for slave mysql> source /usr/mysqll/snapinfo.sql
Query OK, 0 rows affected (0.17 sec)
Configure the query server
to start replication from the
correct position on the
master.
LSMS Active server: As
11. : -
0 the root user, remove the [root@Ismspri root]# rm /var/TKLC/1sms/free/mysql-snapshot*

[root@Ismspri root]# rm /var/TKLC/1sms/free/snapinfo.sql
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NOTE:
12. | LSMS 13.2.X Query EMS changes may cause the Query server to disconnect. These
] Server: steps will help prevent the disconnect.
Start the Mysgl command Jogin: root
line utility # /opt/mysql/mysql/bin/mysql -u root -p

13. | LSMS 13.2.X Query mysql> SET GLOBAL SQL_SLAVE_SKIP_COUNTER = 100;
] Server: Query OK, 0 rows affected

Prepare the Query Server
for the EMS Configuration

14. | LSMS 13.2.X Query
] Server:

Validate the operation of the
query server.

pPerform Error! Reference source not found..

This procedure is complete!

Procedure 22 - CONNECT LSMS 13.2.X TO ELAP

Procedure 22 - Connect LSMS to ELAP

? This procedure connects the LSMS to ELAP.

E | Estimated time:10 minutes

¥

1. | ELAP Active server:
7 | Login to ELAP GUI Login to ELAP GUI through VIP as uiadmin.
2. ELAP Active server: Got Maint S LSMS C tion -> Ch Enabled
1| Evteretows | Saio s e LSS Cometon > CrngeEntle

ELAP_A_NAME Change LSMS Connection Allowed

-
1 TFO: The LSMS Connection is currently Disabled.

A CAUTION: This action will Enable the LSMS Connection.

Enal Connection
ecenber 2

2013 @ Tekelec, Inc, All Rights Reserve: d,

ELAP_A_NAME Change LSMS Connection Allowed

V SUCCESS: The LEMS Connection is now Enabled

27 2013 02:03:19 EST

2013 © Tekelec, Inc., Al Rights Reserved.
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3.

ELAP Active server:
Enable the bulkload.

Go to menu Maintenance -> LSMS HS Bulk Download -> Change Enabled
Click on ‘Enable LSMS Bulk Download for the ELAP’ button.

ELAP_B_NAME Change LSMS HS Bulk Download Enabled

.
1 INFO: The LSMS Bulk Download for this ELAP is currently Disabled.

A CAUTION: This action will Enable the LSMS Bulk Download for this ELAP.

‘ Enable LSMS Bulk Download for this ELAP
Thu June 09 2016 08:50:33 EDT

Copyright € 2015-2016, Oracle and/or its affiliates. All rights reserved.

After clicking on the button,success message will be displayed.

SUCCESS The LSMS HS Bulk Download is now enabled.

This procedure is complete!

Procedure 23 -

ACCEPT THE UPGRADE

Procedure 23 — Accept the upgrade.

S This procedure will accept the upgrade.
E A Estimated time: 5 minutes
P
# T
1. MPS X: Log in to the server| Log1n: root
as the user “root”. Password: <root_password>
O O !
2. MPS X: Start platcfg # su - platcfg
Ol O utility.
3. MPS X: Accept Upgrade
Ol O On the “Main Menu”, select Maintenance and press [ENTER].

Main Menu

Diagnostics

Server Configuration
Hetwork Configuration
Eemote Consoles

Exit

Select the “Upgrade” menu and press [ENTER].
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Backup and Restore
View Mail Quesues
Reztart Server

Exit

—] Maintenance Memu |——

Save Platform Debug Logs

Validate Media

Early Upgrade Checks
Initiate Upgrade

Copy USE Upgrade Image
Hon Tekelec RPM Management

ccept Upgrade
Reject Upgrade
Exit

Select the “Accept Upgrade” menu and press [ENTER].

4| Upgrade Menu Ii

Select Yes and press [ENTER].

Note: The “Reject Upgrade” menu is also available after the LSMS installation.
However, this option should not be used after the first installation of application. It
should be used in subsequent upgrades to return to a previous application release.

I Main Menu

Do you really want to accept the upgrade?
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The accept has completed.

This procedure is complete!
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APPENDIX A. ISO IMAGE COPY FROM USB MEDIA

Assumption: The USB media contains the desired LSMS ISO.

A.1 1ISO IMAGE COPY FROM USB MEDIA

Appendix A.1 - ISO Image copy from USB media

S This procedure provides instructions to copy an 1SO image from an USB media.
T
E|1A | 1B
P
#
.00 B/ISPE? X: Insert Insert media in USB drive
2 olo Mpé X: Loginto | [hostname] consolelogin: root
the server as the password: password
“root” user.
3. OO MPS X: Run Execute the following command:
syscheck to make | # syscheck
sure there is no The output should Tlook Tike:
error. [root@hostname ~]# syscheck
Running modules in class proc...
OK
Running modules in class services...
OK
Running modules in class system...
OK
Running modules in class disk...
OK
Running modules in class hardware...
OK
Running modules in class net...
OK
LOG LOCATION: /var/TKLC/log/syscheck/fail_log
4, OO MPS X: Verify 1SO| Execute the following command to perform directory listing:
image doesn’t # 1s -al /var/TKLC/upgrade
already exist. The output should look like:
[root@hostname ~]# 1s -al /var/TKLC/upgrade
total 16
dr-xr-xr-x 2 root root 4096 Oct 22 16:31 .
dr-xr-xr-x 21 root root 4096 oct 18 13:40 ..
If an 1ISO image exists, remove it by executing the following command:
# rm -f /var/TKLC/upgrade/<ISO image>
51010 |MPSX: Delete Execute the foIIowin}g command to create a directory to mount the USB media:
unwanted 1SOs # mkdir -p /mnt/usb
from USB media. ) )
Execute the following command to get the USB drive name:
# fdisk -1 |grep FAT
The output should look like:
/dev/sdcl * 1 812 831472 6
FAT16
Execute the following command to mount the USB media using the USB drive
name from the output above:
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# mount /dev/sdcl /mnt/usb

Execute the following command to perform directory listing and verify the file

name format is as expected:
# 1s -al /mnt/usb

The output should look like:

[root@hostname ~]# # 1s -al /mnt/usb

total 629400

dr-xr-xr-x 2 root root 4096 Dec 5 13:33 .
dr-xr-xr-x 22 root root 4096 Dec 5 13:55 ..
-rw-r--r-- 1 root root 829595648 Dec 5 16:20 LSMS-
13.2.0.0.0_132.6.0-x86_64.1s0

Only one ISO file should be listed, if additional files are listed, execute the

following command to remove unwanted 1SOs:
# rm -t /mnt/usb/<ISO_NAME>.1iso

Fore.g.,
# rm -f /mnt/usb/ LSMS-13.2.0.0.0_132.6.0-x86_64.1s0

6. OO MPSX:_Verify
space exists for
I1SO.

Execute the following command to verify the available disk space:
# df -h /var/TKLC

The output should look Tike:
[root@Ismspri Togl# df -h /var/TKLC
Filesystem Size Used Avail Use% Mounted on
/dev/mapper/vgroot-plat_var_tklc
3.9¢ 1.2G 2.5G 32% /var/TKLC

Verify that there is at least 620M in the Avail column. If not, clean up files
until there is space available.

CAUTION: Make sure you know what files you can remove safely before
cleaning up. Itis recommended that you only clean up files in the
Ivar/TKLC/upgrade directory as this is a platform owned directory that
should only contain ISO images. This directory should not be expected to
contain images for any length of time as they can get purged. Contact
Technical Services beforehand if removing files other than the
/var/TKLC/upgrade directory as removing files is dangerous.

7. OO Copy iso from
mounted path to

the destination
path

Execute the following command to copy 1SO:
# cp /mnt/usb/<xyz.iso> /var/TKLC/upgrade/

Execute the following command to unmount the USB media:
# umount /mnt/usb

8. OO MPS X: _Verify ISO
image exists.

Execute the following command to perform directory listing:
# Is —al /var/TKLC/upgrade

The output should look like:

The output should look like:
[root@lsmspri logl]# 1s -al /var/TKLC/upgrade
total 895152

drwxrwxr-x. 2 root admgrp 4096 Apr 20 17:16 .
dr-xr-xr-x. 20 root root 4096 Apr 20 18:01 ..
“re——————- 1 admusr admgrp 916621312 Apr 20 17:16 LSMS-

13.2.0.0.0_132.6.0-x86_64.17s0

Repeat this procedure from step 5 if LSMS ISO file is not as expected.
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USB media.

9. MPS X: Logout Logout from the server by executing the following command:
from server.
# logout
10. MPS X: Remove | Remove media from USB drive.

This procedure is complete!
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A.2 Copying LSMS backups from NAS to USB

NAS

This procedure provides instructions to copy LSMS backups from NAS to USB.

P l#rom-don

O

NAS: Insert USB.

Insert media in USB drive

O

NAS: Log in to the
server as the “root”
user.

[hostname] consolelogin: root
password: password

NAS: Run
syscheck to make
sure there is no
error.

Execute the following command:
# syscheck

The output should look Tike:
[root@hostname ~]# syscheck
Running modules in class proc...
OK
services...
OK
system. ..
OK
disk...

Running modules in class

Running modules in class

Running modules in class
OK
hardware. ..

OK

Running modules in class

Running modules in class net...

OK
LOG LOCATION: /var/TKLC/log/syscheck/fail_log

NAS: Mount the
USB media.

Execute the following command to create a directory to mount the USB media:
# mkdir -p /mnt/usb

Execute the following command to get the USB drive name:
# fdisk -1 |grep FAT

The output should look like:
/dev/sdcl * 1
FAT32

812 831472 6

Execute the following command to mount the USB media using the USB drive

name from the output above:
# mount /dev/sdcl /mnt/usb

Note: There should be space available in the USB. If not, clean up files until
there is space available.

Copy backup files
to the mounted
path

Execute the following command to copy 1SO:
# cp <backup files> /mnt/usb/

While copying backup files to USB, Following error is expected:

cp: failed to preserve ownership for “/mnt/usb/<backup_file>": Operation
not permitted
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Note: Please note the ownership of the backup files before copying.Therefore,
after restoring the backups to server after IPM’ing , verify the ownership of
backup files. If not matched, change the ownership with the “chown” command.

6.1 [] | NAS: Verify Execute the following command to perform directory listing:
backup files exists | # Is —al /mnt/usb/

List of backup files should be displayed.

Execute the following command to unmount the USB media:
# umount /mnt/usb

7.1 [ | NAS: Logout from | Logout from the server by executing the following command:

server.
# logout

8. J NAS: Remove Remove media from USB drive.
USB media.
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APPENDIX B. START AND VERIFY REPLICATION ON QUERY SERVER

Appendix B — Start and Verify REPLICATION ON Query Server

Query Server:
Start Replication.

Verify the replication
status on the Query
Server.

NOTE:

If the
Slave_IO_Running
and
Slave_SQL_Running
column values are set
to YES, the status is
good and the next
step can be skipped.

If the
Slave_1O_Running
and
Slave_SQL_Running
column values are set
to NO, wait a few
minutes and then
repeat the “show
slave status \G;”
command

If the values are still
NO, proceed to the
next step.

mysql> start slave;

S | This procedure provides the steps to start and verify Replication on the query server
T

E | This step is performed only if a query server exists in the customer system.

P | Estimated time:30 minutes

#
1. | LSMS13.2.X

Query OK, 0 rows affected (0.00 sec)

mysql> show slave status \G;

Slave_IO_State:
Master_Host:
Master_User:
Master_Port:

connect_Retry:
Master_Log_File:
Read_Master_Log_Pos:
Relay_Log_File:
Relay_Log_Pos:
Relay_Master_Log_File:
Slave_IO_Running:
Slave_SQL_Running:
Replicate_Do_DB:
Replicate_Ignore_DB:
Replicate_Do_Table:
Replicate_Ignore_Table:

JORORORORONOORORORON

. row THR RN AN Sedededededddh
waiting for master to
<Master Host IP>
Tsmsrepl

3306

60

mysql-bin.000134
15778725
cs2-bss2-relay-bin.000001
4137221

mysql-bin.000134

Yes

Yes

ResyncDB,mysq]l

SUupDB.LsmsUserSpid, supDB.LsmsUser,supDB.DbConfig

Replicate_wild_Do_Table:

Replicate_wild_Ignore_Table: ResyncDB.%,supDB.%Key,mysql.%

Last_Errno:
Truncated..........
Seconds_Behind_Master:
1 row in set (0.00 sec)
mysql1>

1008
NULL

TSNSl dddn

send event
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M- W®»

This procedure provides the steps to start and verify Replication on the query server

This step is performed only if a query server exists in the customer system.
Estimated time:30 minutes

LSMS 13.2.X
Query Server:

OPTIONAL:

If the
Slave_IO_Running
and
Slave_SQL_Running
column values are set
to NO, the status is
not good and the
error will need to be
investigated.

Look at last few lines
of error log, and
record the error.

# tail /usr/mysqll/*.err

Record error here:

Contact My Oracle Support following the instructions on the Appendix E and ask for
FULL UPGRADE ASSISTANCE.

w

LSMS Active
Server:

Login to the LSMS
Primary server as
Ismsadm.

Verify the Query
Server is Connected.

Login: Tsmsadm
Password: <1smsadm_password>

[Tsmsadm@Ismspri T1smsadm]$ 1smsdb -c queryservers
cs2-bss2 (<Query Server IP>) Connected
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APPENDIX C. COPYING LICENSE FILE ON THE LSMS SERVER

C.1 Copying File Using SCP

server

S | This procedure will help copying the license file from a desktop to LSMS server
T
E
P
#
1. | Server X: Login to Loging to server using ID and password where license file is copied
[J| server where license file
is present
2. | server X: SCP the file | scp <Ticense file> root@<LSMS IP>: /usr/Tocal/netech/etc/Ticense
LJ| from server to LSMS

3. | LSMS MPS: Check if | Run command to check for license file :
L the license file has been| $ cat /usr/local/netech/etc/license
copied correctly Expected Output : _
Contents of license file should be displayed
This procedure is complete!
C.2 Copying File Using USB
S | This procedure will help copying the license file from a desktop to LSMS server
T
E
P
#
1. Server X: Copy license | Connect USB to desktop and copy the license file from desktop to USB.
L] file to USB
2. [ LSMS MPS: Confirm | Connect the USB to LSMS MPS which contains the license file and check on how it is
L] how the USB is enumerated using command :
enumerated on LSMS | $dmesg | grep -i "removable disk"
server Expected output
sd 6:0:0:0: Attached scsi removable disk sdc
This shows USB is enumerated as /dev/sdc
3. | LSMS MPS: Determine| Run command fdisk —I on enumerated name device to determine partition name :
L] the partition name $fdisk —I /dev/sdc

Expected Output :

Disk /dev/sdc: 2013 MB, 2013265920 bytes

256 heads, 63 sectors/track, 243 cylinders

Units = cylinders of 16128 * 512 = 8257536 bytes

End
110

Device Boot Start

Blocks Id System
/dev/sdcl * 1

887008+ b W95 FAT32

This shows that partition name is /dev/sdcl

Full Upgrade for LSMS 13.2

89 of 92




Software Upgrade Procedure

Full Upgrade for LSMS 13.2

4. | LSMS MPS: Copy Run below command to copy the license file from USB
L] ticense file from USB to| $mkdir -p /tmp/usb
MPS $ mount /dev/sdcl /tmp/usb
5. | LSMS MPS: Copy $ cp /tmp/usb/<license-file> /usr/Tocal/netech/etc/Ticense
L| ticense file from /tmp
directory
6. | LSMS MPS: Check if | Run command to check for license file :
1| the license file has been | $ cat /usr/local/netech/etc/license
copied correctly
Expected Output :
Contents of license file should be displayed
7. | LSMS MPS: Unmount | Unmount the USB using command :
L] the USB $umount /tmp/usb
This procedure is complete!
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Date

Test
Case

Description of Failures and/or Issues.
Any CSR’s /| RMA’s issued during
Acceptance. Discrepancy

Resolution and SWOPS
Engineer Responsible

Resolution
Date:
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APPENDIX E. MY ORACLE SUPPORT

ACAUTION: Use only the guide downloaded from the Oracle Technology Network (OTN)
(http://www.oracle.com/technetwork/indexes/documentation/oracle-comms-tekelec-2136003.html).

Before upgrading your system, access the My Oracle Support web portal (https://support.oracle.com) and review any
Knowledge Alerts that may be related to the System Health Check or the Upgrade.

Before beginning this procedure, contact My Oracle Support and inform them of your upgrade plans. If installing for an
Oracle customer on a customer site, obtain the customer's Support Identifier (SI) before requesting assistance.

Web portal (preferred option): My Oracle Support (MOS) (https://support.oracle.com/)

Phone: Contact your local Oracle Global Customer Support Center (http://www.oracle.com/support/contact.html)

Make the following selections on the Support telephone menu:

1. Select ‘2’ for New Service Request
2. Select ‘3’ for Hardware, Networking and Solaris Operating System Support

3. Select ‘1’ for Technical Issues and when talking to the agent, please indicate that you are an existing
Tekelec customer


http://www.oracle.com/technetwork/indexes/documentation/oracle-comms-tekelec-2136003.html
https://support.oracle.com/
https://support.oracle.com/
http://www.oracle.com/support/contact.html

